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Introduction
Since the release of Microsoft® Project 2000, we have devoted significant time and resources to collect and incorporate feedback from our current users, general knowledge workers, and expert project managers. The result of our efforts is Microsoft Project 2002, which offers major feature additions and enhancements over Microsoft Project 2000.

The Microsoft Project family product line has been expanded:

· Microsoft Project Standard 2002 is the new version of our core project management tool. When used by itself, Microsoft Project Standard is recommended for single users who manage projects from their personal desktop computers. 

· Microsoft Project Professional 2002 is a new desktop application aimed at organizations that require enterprise project management functionality. Microsoft Project Professional includes all the features of Microsoft Project Standard, and more. You must use Microsoft Project Server with Microsoft Project Professional to take advantage of the enterprise project management features. 

· Microsoft Project Server 2002 is our new product that serves as the platform for team and enterprise project management (this is the upgrade path for Microsoft Project Central Server users). We have added many new features to Microsoft Project Server (over Microsoft Project Central Server), including enhanced security and the integration of Microsoft SharePoint Team Services to enable you to organize, store, and track project-related information including documents, issues, and reports in a central shared location.

· A Microsoft Project Server Client Access License (CAL) is a license that gives a user the right to access the services of Microsoft Project Server. Users with a Microsoft Project Server CAL can view and update project information from Microsoft Project Server through the Web-based interface called Microsoft Project Web Access, including updating timesheets, tracking issues and storing documents, portfolio management and task delegation. We have included a CAL with each desktop application (and five CALs with the retail version of Microsoft Project Server). Additional CALs are available via volume licensing. 

Project management scenarios

Microsoft Project Standard, Microsoft Project Professional, and Microsoft Project Server — along with the Microsoft Project Server CALs — can be used to build three different project management scenarios for you and your organization. 

· Project Management: As a standalone application, Microsoft Project Standard includes a comprehensive set of features to support project management fundamentals including task scheduling, resource management, tracking, and reporting.

· Enterprise Project Management Solution: For an enterprise project management solution, your organization needs Microsoft Project Professional plus Microsoft Project Server and Microsoft Project Server CALs. Through the new functionality of these products, your company can manage, view, and analyze your organization’s entire portfolio of projects using custom enterprise codes; ensure consistency in data entry and reporting; as well as manage resources through a central resource pool.
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Microsoft Project 2002 Design Goals

The new features of Microsoft Project 2002 support three primary design goals: 

· Intuitive Project Management: Make Microsoft Project more intuitive for new and existing users by including new features and an improved user interface; 

· Accessibility and Collaboration: Increase the accessibility of project data and enable improved collaboration on projects; 

· Project Management Platform: Provide a project management platform to enable users to customize and extend their use of the tool to fit their needs.

New Features At-A-Glance

Below is a table to give you a quick “at a glance” understanding of the primary changes in Microsoft Project 2002. The following codes are to help you understand which product the given feature is found. The codes are: 
Microsoft Project Standard = Std
Microsoft Project Professional = Pro
Microsoft Project Server = Svr
Microsoft Project Server CAL (Project Web Access) = Pwa
Microsoft Project Standard and Microsoft Project Professional
	Feature
	Description
	New or Improved
	Product

	Project Guide 
	This interface guides you through the project management process, and empowers you to learn, explore and discover.
	New


	Std & Pro

	Office Integration 
	To be consistent with the look and feel of Office XP, Microsoft Project’s command bars have a new look. The Open/Save and File New dialogs have been enhanced, there are improved Search capabilities. All these changes are now part of a side workpane. 
	New


	Std & Pro

	Safe Mode
	If you encounter an unexpected crash and/or file/registry corruption, this feature allows you to start the application with certain parts of the application disabled so you may continue working.
	New


	Std & Pro

	SmartTags
	These provide an explanation of scheduling engine results, as well as an easy means for you to change these results. You can not change and create your own SmartTags in Microsoft Project as in Microsoft Office XP.
	New


	Std & Pro

	Small ease of use features 
	1. DEL Key no longer deletes a row; just the cell selected will be cleared.

2. Manual header row height adjustment and header cell text wrap is now available.

3. Automatic row height adjustment when text wrapping is set to true.

4. Edit mode is maintained when you switch away to another application and then come back into Project.

5. Easy resizing on Usage view timescale table columns

6. Enable column edits in a split screen

7. A third level has been added to views with a timescale.
	New


	Std & Pro

	New Project Wizard
	This walks you through generating a new project plan, it enforces the correct use of Enterprise custom fields, suggests collaboration, and attaching supporting documentation.
	New


	Std & Pro

	Calendar Wizard
	This allows you to setup calendars and options that effect the project all in one place.
	New


	Std & Pro

	Tracking Setup Wizard
	This helps you pick an appropriate tracking method, manually track or use Microsoft Project Server. The wizard dynamically creates a customized ‘tracking view’ based on the method chosen.
	New


	Std & Pro

	Import/Export Mapping Wizard
	This new wizard makes it easier to move data between Microsoft Project and other applications, including 3rd party apps and XML.
	New


	Std & Pro

	Import Outlook Tasks Dialog
	This dialog allows a project manager to begin their project plan in Outlook’s Task List, and then easily move their tasks into Microsoft Project.
	New


	Std & Pro

	Excel Task List Template
	This template allows a project manager to begin their project plan in Excel and then easily move their tasks, resources and assignments into Microsoft Project. 
	New


	Std & Pro

	Grouping
	The improvements support grouping on assignment fields and rollups of time-phased fields in the usage views.
	Improved


	Std & Pro

	Group Styles
	This allows you to customize the colors of the different grouping levels in the Microsoft Project Server Timesheet as well as the Project, Portfolio and Resource Views.
	Improved/


	Pwa

	Network Diagram View
	You can now group nodes in this view. You can also display standard indicators and graphical indicators for custom fields.
	Improved


	Std & Pro

	Print View Totals
	Enables enhanced reporting capabilities from Usage views. Includes row and column totals in Usage views.
	New


	Std & Pro

	Multiple Baselines and additional Baseline fields
	You can now save and store full baseline data multiple times (11) over the course of a project.
	New


	Std & Pro

	Rollup Baseline data to Summary tasks on a selective baseline save
	Now when you save baseline data on selected tasks, or if tasks are deleted, there are options to save new baseline data for the associated summary tasks. This maintains accurate baseline data for all tasks.
	New


	Std & Pro

	Update Project
	When you update a project and reschedule remaining work, constrained tasks that have no progress are no longer changed. This preserves the task’s constraint. Also, the date for which you select to reschedule work is not restricted to future dates but allows rescheduled work to be again rescheduled to an even earlier date.
	Improved


	Std & Pro

	Calculation Options
	These calculation options allow you to automatically adjust where actuals and remaining work are placed according to the status date of the project.
	New


	Std & Pro

	Earned Value, additional fields and calculation options
	New fields have been added. You can also choose which baseline the earned value calculations are be based on. Likewise, you can choose to calculate earned value on the physical % complete instead of task % Complete.
	New


	Std & Pro

	Microsoft Project Server Pages displayed in Project
	Information from Microsoft Project Server can be displayed in Microsoft Project. Now a project manager can easily check the accuracy of information in Microsoft Project Server before they update the project plan with that information. 
	New


	Std & Pro

	Collaborate Menu
	This top-level menu replaces Workgroup under the Tools menu to accomplish more discoverable and intuitive use of the features for Microsoft Project Server.
	New and Improved


	Std & Pro

	Assignment dialog
	This allows you to search for a particular resource based on information such as skill, availability ranges, pay rate etc. You can also add resource information from your address book, Microsoft Project Server, the Enterprise Resource Pool, or the Active Directory, thus eliminating time consuming data entry.
	New and Improved


	Primarily Pro

	Generic Resource
	Generic resources support skill-based resource assignment and replacement by allowing you to define and save frequently used skill/code profiles as generic resources.
	New


	Pro & Svr

	Enterprise Resources
	These are resources stored on the server that may be assigned to tasks in one or more projects in the Microsoft Project Server.
	New


	Pro & Svr

	Enterprise Resource Pool
	This provides a single repository for all enterprise resources and relieves scalability issues associated with previous versions.
	New


	Pro & Svr

	Enterprise Global Template
	This stores company or department wide standard information.
	New


	Pro & Svr

	Enterprise Custom Fields
	Now you can provide specific information about your resources that can assist in building the team for your project plan.
	New


	Pro & Svr

	Resource Substitution Wizard
	This allows you to specify what kinds of resources you need and Project automatically searches out the resources that best fit your timeline and skill needs. It also is used to do assignment replacements and to model portfolios.
	New


	Pro & Svr

	Build Team from Enterprise
	This option assists in the selection of resources and allows you to find resources for use in your project plan from the enterprise resource pool.
	New


	Pro & Svr

	Versions
	This allows you to save different versions of a project plan so you can then do full comparison between projects, trend analysis, and what-if scenarios and do better reporting.
	New


	Pro & Svr

	Portfolio Modeling
	This adds the ability to perform “what-if” analyses on project portfolios.
	New


	Pro & Svr using Pwa

	Analysis Views (Portfolio Analyzer)
	This presents project and resource data that you can pivot around and analyze in a variety of ways.
	New


	Pro & Svr using Pwa

	Resource Center View
	This allows you to view, group and edit Enterprise resource information. Also to drilldown into resource availability across multiple projects. 
	New


	Pro & Svr using Pwa

	Resource Availability Graph
	This adds graphical views of assignments that can be used to quickly identify when and why one or more resources are under or over-allocated.
	New


	Primarily Pro

	Logon Accounts
	This allows you to create connections to a Microsoft Project Server, and open projects and the associated global files stored there. If more than one server is available you can set additional accounts to point to other servers. 
	New


	Pro & Svr

	Microsoft Project Server login from Project
	This gives the ability to authenticate a user against Microsoft Project Server security, to access features that involve connecting to a Microsoft Project Server, and displaying this information in Project.
	New


	Pro & Svr

	Backward Compatibility
	This allows a saved file from Microsoft Project 2002 to be opened and modified in version 2000, and then reopened in version 2002. However new fields and features will not be viewable, but will not be lost on the round-trip from version 2002 to 2000 and back to 2002.
	Improved


	Std & Pro

	Forward Compatibility 
	This allows data in new fields from a future version of Microsoft Project to be displayed in Microsoft Project 2002.
	New


	Std & Pro

	Multiple Project Manager Support
	This new support allows Multiple managers within one project plan, to manage resources they have sent assignments to. Also Project Managers can easily transfer responsibility for managing a project to another manger.
	New


	Std & Pro with Svr

	Office Watson 
	This provides a method for documenting system issues that will be easy for the user to report, and useful information to send to Microsoft in order to improve the next release or version of Microsoft Project.
	New


	Std & Pro


Microsoft Project Server

	Feature
	Description
	New or Improved
	Product

	Microsoft Project Server Compatibility 
	This allows compatibility between Microsoft Project Server 2002 and Microsoft Project 2000 and vise versa, relieving the necessity of upgrading both the server and the client at the same time across the company. 
	New


	Svr

	Microsoft Project Server Scalability
	You can now use load balancing for your web servers and clusters for your database server to handle large volumes of activity.
	New


	Svr

	New Look for Microsoft Project Server 
	Microsoft Project Server has adopted a new style and look to be more consistent with other Office web applications and to accommodate new features.
The Microsoft Project Server Home Page is cleaner; is less cluttered and allows you to immediately see new items that you need to take action on.

The Timesheet view is simple and streamlined.

The Portfolio view will allow you to edit Enterprise custom fields; also to group on these fields.
	Improved


	Svr using Pwa

	Updates section on the Home page
	This section replaces the Messages link on the Home page. You can review and select which changes are updated to Microsoft Project and you have the ability to review historical information.
	New


	Svr using Pwa

	Comments Field
	The Comments field in a reply notification is accumulated as notes on the task in Project 2002.
	Improved


	Svr using Pwa

	View Improvements
	View settings are persisted when switching between views; links to these settings can be saved in the sidepane as well.
	Improved


	Svr using Pwa

	Notifications
	If there is a problem updating data to the Microsoft Project Server, a more discoverable alert pops up to explain the issue and for you to take action. .Email notifications via SMTP email replace the messages section of Microsoft Project Server’s Home page. Notifications go out when a user action initiates new or changed information or when active email reminders are triggered. The user or manager can also specify what types of email notifications are sent.
	New


	Svr using Pwa

	Spooler Improvements
	The spooler that communicates with Microsoft Project Server has been improved so that it gives better actionable error messages and so that it “pops up” to grab your attention.
	Improved

	Svr using Pro & Std

	Selectively Update tasks
	This allows resources to select specific tasks instead of all tasks when updating task status.
	Improved


	Svr using Pwa

	Updates to Actuals
	This allows a resource to modify actuals on any day, and the changes are sent to the Project Manager for update, unless restricted by the Project Manager or Microsoft Project Server Admin. If there is a problem you will get a popup and there’s verbose information to tell you what’s wrong.
	Improved

	Svr using Pwa

	Grid Controls
	Enhanced with a richer set of tools for analyzing and grouping projects.

· Display of splits in the Gantt view

· Support for multiple hierarchies in grouping

· Phased Portfolio Rollup views

· Additional autofilter conditions

· Search capabilities

· Pick Lists in Custom Fields


	Improved


	Svr using Pwa

	Microsoft Project Server To-Do Task List
	Allows you to create and manage a simple list of tasks in Microsoft Project Server and make it easy to open this list in Microsoft Project.
	New


	Svr using Pwa

	Document Library and Microsoft SharePoint Team Services Integration
	This enables document sharing and tracking on individual projects and tasks posted to Microsoft Project Server. 
	New

	Svr using Pwa

	Issues Tracking
	This tracks issues related to a project or tasks and helps resolve issues using simple business processes.
	New

	Svr using Pwa

	Check-in and Check-out
	When multiple users need to access the same project, this provides a secure method of controlling access to enterprise projects. 
	New


	Svr using Pro


Microsoft Project Programmability

	Feature
	Description
	New or Improved
	Product

	Microsoft Project Server Object Link Provider
	This solution allows enterprise you to integrate Microsoft Project Server with your own document management or issue tracking solution.
	New


	Svr using Pwa

	Project Guide
	An Enterprise can use the Project Guide to enforce a process or project management best practices. You can modify the Project Guide using new objects from Microsoft Project’s Object Model.
	New


	Std & Pro

	Microsoft Project Server ActiveX controls
	This improves and extends the programmable interfaces of the controls in order to provide more opportunities to extend and customize Microsoft Project Server.
	Improved


	Svr using Pwa components

	Project OLE DB 
	This allows support for timephased data, better support for Office web components and improved scalability and reliability.
	Improved


	Std, Pro & Svr

	Project Data Server (PDS)
	This is the middle tier data access component for all portfolio data. The PDS utilized XML as a data transport mechanism and passes well-formed schema derived XML streams. The PDS also acts as the security layer to filter the data based on the individual user.
	New


	Svr

	Dashboard View
	This provides you with a group of shortcuts within Outlook that provides you with easy access to specific Microsoft Project Server information. Microsoft Project Server web pages have been broken into smaller components in order to allow for more opportunities for Web Part creation without writing your own ASP pages.
	Improved


	Pwa components

	New Object Model extensions, new events
	New object model enhancements and new events.
	New / Improved


	Std & Pro


Microsoft Project Standard and Microsoft Project Professional
Project Guide 

The Project Guide is accessed via a new Toolbar called the Project Guide. The Project Guide includes options for Tasks, Resources, Track, Report, Hide/Show, and Next Steps and Related Activities. When an option is selected from the Project Guide toolbar, a side-pane is displayed with a list of Help topics on the left of your screen. The Hide/Show option simply closes or opens the side-pane for the selected option. Next Steps and Related Activities displays all the default Project Guide based help available. The remaining options offer detailed information on each topic and include wizards to walk you through some specific goals. The View to the right of the sidepane updates to correspond with the action selected. Likewise the sidepane updates to display pertinent information as new data is entered into the project plan. 
If you do not want to use the Project Guide at all and don’t want it displayed, there is an option to turn off the Project Guide all together. Go to the Tools menu, click Options and select the Interface tab. Under the section for Project Guide settings, clear the checkbox next to Display Project Guide.

Here is what the Project Guide looks like when you launch Microsoft Project and select Tasks from the Project Guide Toolbar:
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The Project Guide can be customized to include other goals and tasks that are specific to your organization.
Office Integration 

As with previous versions of Microsoft Project there’s a consistent look and feel to the other Office products. Some of the consistencies you’ll find in Microsoft Project 2002 are: 


· The appearance of the Command Bars is one-dimensional and as you pass the mouse over the Toolbar, each option is framed and highlighted in turn. 
· Microsoft Project now supports Drag and Drop of columns. Just click on the title for a column and drag it to a new location in the table. 
· The File Open/Save dialog shows the most recently used file list, project templates and the option to browse web locations for more templates are available from a task pane as illustrated below on the left-hand side.
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Safe Mode 

If Microsoft Project were to encounter a problem while launching, Safe Mode will allow you to start the application with certain parts of the application disabled so that you can continue working in Microsoft Project. Cases in which Safe Mode would automatically be invoked include an unexpected crash, file or registry corruption. 
Smart Tags
Microsoft Project uses smart tags to explain project scheduling engine calculations and advise users of alternate actions that may be more desirable. This feature is similar to the scheduling messages that Microsoft Project already employs, the difference being is that feedback is less intrusive to your workspace. A green triangle in the edited cell indicates that the edit just performed has made a change to the task that has scheduling ramifications. The indicator only appears in the view types of Gantt, Sheet and Usage. Hovering over the indicator displays a notice of a scheduling change and clicking on the indicator displays alternate choices. The indicator in most cases displays as long as the edit is undoable, once a new edit is made the indicator disappears. Edits for which Feedback indicators display are:


· Additional resource assignment

· Edits to Start and Finish

· Edits to Work, Units or Duration

· Deletion in the Name column

Feedback can be tuned off by going to the Tools menu and clicking Options and then selecting the Interface tab and deselecting the various checkboxes in the “Show indicators and Options buttons for” section. Feedback in Office XP can be programmatically modified using the smart tags SDK. However, the SDK for Office XP will not work with Microsoft Project 2002.

Here is an example of how a Smart Tag will present itself in Microsoft Project:
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Small Ease of Use Features

· DEL Key no longer deletes a row; just the cell selected is cleared. In the case of the Del Key being selected while in the Name column, Feedback asks whether the entire row should be deleted or just the task name.

[image: image5.png]() Delete the entire task.

@ [TaskName Durtion | Start Fiish  B.01 Sep 30,01
TWIT[F[S|SM[T W]
i  Summary. Ssdws?  omo saden
2[R~ ] tsoms  snim snem
8 |
© orly dear the contens of Taskame cal | 21201 830
B anamn snam




· Header cell row height is now manually adjustable as well as having the ability to automatically wrap text in the header cell. By default the option to automatically wrap text in cells is turned on. To turn off this option, go to the View menu and click Tables, click More Tables and select the table you wish to edit. Deselect the option to Auto-adjust header row heights. To manually adjust the row height, simply drag the bottom border of the row to the desired height. Manually adjusting the header row height turns off automatic text wrap, however, double clicking on the header cell and selecting Best Fit will again enable automatic text wrap. 

Below is an example of text wrapped in a Header cell:
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· Entry mode is maintained when you switch away to another application and then come back into Microsoft Project.

· Resizing the width of columns in a Usage View Timescale can be done by dragging a column to the desired width; all columns in the timescale are affected. Use CTRL+Z to reset the width back to its original size. When the Master pane is resized the Slave pane is resized as well.

· Column edits such as Insert, Edit, and Hide can be done in the slave pane (the bottom of a split view window) even when no data is displayed in the slave pane.

· A third level for timescale labels has been added to views with a timescale. The levels are referred to as Top, Middle and Bottom tiers and can be modified when selecting Zoom from the View menu, or from the Format menu and select Timescale or by double clicking in the timescale header itself. Middle and Bottom are displayed by default and used for backwards compatibility. 


Here is an example of a timescale with three levels:
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· The timescales always line up together. When a Task or Resource Usage view is displayed in a split screen, you have the ability to add additional fields of information. Right click in the timescale and select additional field names. The timescale details header column also appears.


Below is an example of a split screen view with a Gantt chart in the top pane and a Resource Usage view in the bottom. The Work field displays in the Details section:
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New Project Wizard 

There are two ways to access the wizard: From ‘Define a project’ in the Project Guide, or from the File New work-pane. The steps include:

1. Define the Project – You are asked to enter a start date for the project unless the project is set to schedule from finish, in which case you are asked the estimated date you want your project to finish. 
2. Collaborate on your project – This step is not displayed if you’re using a Microsoft Project Server account. This step advertises Microsoft Project Server for collaboration with your resources. If you have already used Microsoft Project Server then the “Yes” radio button is selected by default and connection information to the Microsoft Project Server is populated, else the “No” radio button is selected. If you choose “Yes” but have not used Microsoft Project Server before, then a link to “Set Connection” is displayed. If you wish to change your Microsoft Project Server connection, then link the “Change connection information” is displayed. If you choose “No” then information on “How to Setup Microsoft Project Server Later” is displayed. 
3. Save your Project – Your project must be saved at this point before proceeding. If using Microsoft Project Server accounts then text is displayed informing you that your project will automatically register with a Microsoft Project Server on save. 

4. Add documents relating to your project – This step takes you to a SharePoint Team Services document library where you can upload documentation pertinent to your project plan, such as project justification, project feasibility analysis, and/or budget estimation.

5. Enter additional information – At this point you are directed to a link “Save and Finish” that then exits the wizard and allows you to continue to follow the steps in the side-pane to start entering tasks into your project. 

Calendar Wizard 

This wizard can be accessed via the Project Guide by selecting Tasks and then selecting “Define general working times”. The steps include:

1. Define the project’s general working times – This step draws a graphical representation for the working time to the right, specified by the template chosen. The dropdown list for templates includes all base calendars defined in the global file. If no template is chosen then a standard 8am to 5pm, Monday through Friday calendar is displayed.

2. Define the work week – Here you check which days are working. Next you have an option to accept the current working hours or define new working hours. If you select the radio button to adjust working hours the side-pane displays a dropdown from which you can select which day you want to change. There are two sets of fields for editing working time known as shifts. If you wish to show and edit more shifts, click on the link “Specify additional shifts”. You can then select to apply the new working time to all working days or select a new day from the dropdown list. You can also select to make the new hours a default in all project files by selecting “set as default”. 
3. Set Holidays and Days Off– If you want to define exceptions such as holidays, click the link to “change working time”. The “change working time” dialog is displayed. The side-pane provides a detailed explanation on how to make exceptions. 
4. Define time units – In this step you define how many hours a day will equal, and how many days a week and a month is equal to. These units are synchronized with those in the Options Calendar tab under the Tools menu. 
5. The project calendar is set – This step informs you that you have just set the calendar that affects all resources in this project. If you need to set up additional calendars for resource groups a link is provided, otherwise you can save and exit the wizard.

Selecting the link to define additional calendars takes you through the following steps:


6. Define additional calendars – You are asked if you would like to create a calendar or edit an existing calendar. If you chose new then you need to enter a unique calendar name. If you chose Edit then click Next to show a list of available base calendars.

7. Define general working hours – This interface is very similar to that of step 1 above. Define the project’s general working hours; however, the text indicates that you are now setting the working hours for a new calendar or for one you have selected to edit.
8. Define the work week – This is the same as the above step 2. Define the work week.
9. Set Holidays and Days Off – This step is the same as the above step 3. Define exceptions.
10. The additional calendar is set – The calendar is set; Save and Finish to exit the wizard.

There is also a wizard for setting resource calendars, which is initiated by clicking Resources from the Project Guide and selecting “Define working time for resources.” You are walked through how to set resource calendars using the following steps:


1. Specify working hours for individual resources – A Resource Sheet view is displayed with the Calendar field displayed, so you can discover what calendar your resources are already using. You are given a link to “define additional calendars” if you need to define a calendar for a group of resources whose working time differs from that of the project base calendar. If you want to change working time for one resource at a time instead of a group, then you select the resource name and continue in this section of the wizard.

2. Define general working hours – same as step 1 above.
3. Define the work week – same as step 2 above.
4. Set Holidays and Days Off – same as step 3 above.
5. The resource calendar is set – You can chose to save and exit the wizard or loop back through for additional resources.
Tracking Setup Wizard 

This wizard can be found by selecting Track from the Project Guide and click “Prepare to track the progress of your project.” The following steps will guide you through how to track progress on the tasks in your project plan.

1. Entering Progress - The first step of the wizard allows you to pick between manual tracking or tracking with Microsoft Project Server. If Microsoft Project Server has been used in the past then the “Yes” radio button is selected by default and the server URL is listed under Microsoft Project Server Website. If “Yes” is selected but a Microsoft Project Server has not been setup then a link displays “Set Connection Information for the Microsoft Project Server” which will take you to the Setup Microsoft Project Server side-pane with detailed information on how to setup Microsoft Project Server. “No” can be selected whether or not you have Microsoft Project Server setup. 
2. Tracking Method - When using Microsoft Project Server for tracking, four options are displayed. If the Microsoft Project Server Administrator has locked down the tracking method then only that option is available. If Microsoft Project cannot connect to the URL for the Microsoft Project Server specified in step 1, then an error message is displayed in this step and a link to “Change Connection Information” is provided. You will not be able to proceed until a connection is made. When you’re not using Microsoft Project Server for tracking then only three tracking methods display. When a method is chosen, a brief explanation of each method is displayed. Regardless of whether Microsoft Project Server or manual tracking is invoked the view to the right of the side-pane dynamically creates a custom tracking view and custom tracking table most appropriate for the method selected. This view is stored in the project file. If a custom view of the same name has already been created, Microsoft Project adds any additional fields needed for the method selected. If manual tracking has been selected then you will save and exit the wizard.

3. Publish Assignments – This step is only available when using Microsoft Project Server for tracking. In this step, Publish Assignments sends notifications for your entire project to your resources about their tasks. If you wish to customize the information that goes to your resources a link is provided. If a connection to the Microsoft Project Server cannot be made the same error message as seen in step 2 is displayed. Save and exit the wizard.

Import/Export Mapping Wizard 

The Import/Export Mapping dialog has been replaced with a wizard. This wizard is not available on the Project Guide but launches when you open a file that Microsoft Project does not recognize as a full project. Likewise, when you choose to Save As a non-project file type the Export wizard is launched. The steps for the Import wizard are listed below:

1. Welcome screen - no options are found here. It’s just an explanation of what the wizard can do.
2. What is the format of the data you want to import? – If Microsoft Project recognizes the file type (such as Access) then you can choose Full project. In any case you can choose unmapped or selective data. Selecting Unmapped skips the mapping screens and Microsoft Project will do its best to automatically map your data types to project fields.

a. A full project 

b. Only selective data

c. Unmapped data

3. Open Project – This option displays if Full project is selected.

4. Create a new or existing map? – This screen displays if you choose selective data.

a. New map

b. Use existing map

5. Choose a map screen – This screen displays if you choose existing map in the step above. All available maps in the Global file are listed.

6. How do you want to import this file? – You can choose to create a new project with your imported data or append the data to a project that’s already open. Lastly you can merge your data into an open project, which overwrites tasks, resources, or assignments that matches the records based on the key field you indicate to use for a merge.

a. New 

b. Append

c. Merge

7. Select the type of data you want to import. – Tasks, resource and assignments must be mapped separately to the appropriate fields in Microsoft Project. 
a. Tasks

b. Resources

c. Assignments

There are additional options in the bottom half of the screen that change depending on the file type. For example with an Excel file type you can choose to import the header column names.

8. Map data – If you choose selective data; this is where you map the fields from the non-project file with Microsoft Project’s fields and determine a key field to merge data into an existing project file.

9. Congratulations! – This screen indicates the import is complete and gives you a button to save the map from earlier steps.
10. Save map – Here you can save the map you created in earlier steps to be used in future import operations.

Import Outlook Tasks Dialog 

This feature can be accessed by going to the Tools menu and clicking Import Outlook Tasks. The dialog displays all the Task folders from your Outlook client, but will not pull tasks from Public folders. The tasks are grouped by Folder name and then Category name. Select tasks to import by clicking the checkbox to the left of the task name. Multiple tasks can be selected by holding down the control or shift key while selecting the tasks or chose a group of tasks by clicking the checkbox next to the category name. There is a Select All button as well as Clear All button for more efficiency. Once you’ve made your selections for import, click the OK button. The Outlook tasks are appended into the currently open project. Task dates, as defined in Microsoft Outlook, are ignored when imported and are scheduled using Microsoft Project’s scheduling engine.
Here is a look at the dialog for selecting Outlook Tasks:
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Excel Task List Template 

A new Microsoft Excel template can be used to start a project plan in Excel such that it’s quick and easy to import/export the data to or from Microsoft Project. The template is saved into the Office template directory (drive:\Program Files\Microsoft Office\Templates\1033) so it is easy to discover from within Excel. There are three primary sheets in the workbook, one each for Tasks, Resources and Assignments (there’s a fourth sheet named Info_Table which has information but should not be modified). The Task_Table default fields are ID, Name, Duration, Start, Finish, Predecessor, Outline Level, and Notes. The Resource_Table sheet default fields are ID, Name, Initials, Type, Material Label, Group, Email Address, Windows User Account, Standard Rate, Cost Per Use and Notes. The sheet titled Assignment_Table default fields are Task Name, Resource Name, % Work Complete, Work and Units.  When used to import or export data to or from Microsoft Project there is no need to map data fields. If you edit the template, Microsoft Project will do its best to map any additional fields automatically.

Grouping 

You can now group on assignment fields as well as rollup time-phased data totals to group summary rows in Usage views. The dialog has a new option checkbox “Group assignments, not Task” (in a Task Usage view) or “Group assignments, not Resources” (in a Resource Usage view). All assignment time-phased fields are rolled up except for the following: Cumulative Percent Complete, Over-allocation, Peak Units and Percent Allocation. 
To group on assignment fields:


1. In a Usage view click on Project and click Customize group by…
2. Select the field/s you wish to group on. 
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Microsoft Project Server Grouping Styles 

This feature allows the Microsoft Project Server administrator to set colors for different grouping levels in the Timesheet, Project, Portfolio, Resource and Vision Views. This makes it easier to identify the different levels of grouping in these Microsoft Project Server views. The administrator can change the color and the intensity of the color for the grouping level cells, and also the color and font style of the text displayed inside the cells.

To use this feature:

1. Log on to Microsoft Project Server as Administrator

2. Click the Admin tab and in select “Customize Microsoft Project Web Access.” Next, select Group Formats. 
3. Select a Grouping Scheme from the dropdown list. All schemes are listed for you reference.

4. Use the Rename button to change the name of the grouping style if you wish.

5. Click in each cell to change the attribute. Click on the arrow for the dropdown list for the options available.

6. Click the Save Changes button when you are satisfied with your modification.

After you have modified the group format, you then need to apply this format to a specific view.

1. Log on to Microsoft Project Server as Administrator

2. Click the Admin tab and select Manage Views 

3. Select a view and click Modify view or click New view.

4. In the Grouping Style scheme dropdown list select the scheme you would like to apply for this view.

5. Click OK.


The grouping style is set for the view and next time you navigate to that view the new grouping styles will display.

Network Diagram View 

Two features now available in this view are Grouping and the ability to display standard indicators and custom fields. 

To apply a Group:

1. Click the Project menu and select Group By: 

2. Select the field you wish to group by or choose More Group… or Customize Groups By….

Grouping in the Network Diagram is designed to look and feel very similar to grouping in the Gantt view where a colored banding on the row differentiates the group summary tasks in the sheet. The Network Diagram has horizontal colored banding inserted into the diagram to separate the nodes into data bands according to the grouping criteria. 
The dialog to format grouping is the same user interface as in a Gantt Chart view. You can choose the color of the group banding, the font and whether to show summary tasks or not. Format layout in this view uses automatic layout while grouping, but the layout is not persisted when you remove grouping, so your custom layout is not lost. The Arrangement option is grayed out as well as Show summary tasks. But as stated earlier you can select to show summary tasks in the Group by dialog. Zooming into the view does not affect the group summary tasks size. 
When printing, the Group label displays to the left so that you always know what the group band represents. In order to view field rollup information for a group, use the mouse to hover over a band and a ToolTip will display the rollup information. You can make edits to tasks while in a grouped mode but you cannot add new tasks.


To display Standard Indicators and Custom Fields:

1. Click the Format menu and select Bar Styles

2. Click the More Templates button

3. Select a template or click the new button to create a new template, to add the Indicator field or a Custom field that has already been created.

You can choose to preview data from a specific task. If the indicator does not display right away, just click in the cell and the indicator will display; the cell will be blank if there are no indicators for the selected task. Custom field indicators appear as soon as the field is added to the template. The size of the indicator can be adjusted by changing the font size. Likewise, zooming enlarges the indicator along with the node. ToolTips display for the indicator whenever the mouse is used to hover over it. To edit a custom field that displays a graphical indicator, the first click brings focus to the cell and the second click allows you to enter new data.

Print View Totals 

The Page Setup dialog has two new checkboxes: “Print column totals” and “Print row totals for values within print date”. When “Print column totals” is checked, totals are calculated in memory and a row is added to the printout, with totals for the time-phased data as well as for sheet data. When printing a Usage view and when the option to “Print row totals for values within print date” is checked, a column is added to the printout with totals for the time-phased data within the date range as specified in the Print dialog. These options are enabled only in the Task and Resource Usage views. The column totals are only printed on the last page, but before any Notes pages. Changing the font for the column headings modifies the font for the totals row.

Here is an example of column totals in a print preview:
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Multiple Baselines 

This feature allows you to save all baseline fields up to a total of 11 times for one project. The Save Baseline dialog now has a dropdown list for each of the 11 baselines.  Likewise, the Clear Baseline dialog has the same dropdown list. When a Baseline is saved, the last date saved is stored with the baseline as well and is displayed in the dialog for future reference. Below is snapshot of the Save Baseline dialog where Baseline 5 was saved on 8/13/01.
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The “Save interim plan” fields also allow you to move one baseline to another. To accomplish this, ten additional Baseline Start, Baseline Finish, Baseline Work, Baseline Duration, and Baseline Cost have been added. You can now choose which baseline you would like to use in Earned Value calculations (more discussion on this in the Earned Value section). 
To access the Save to Baseline dialog: Click the Tools menu, select Tracking and click Save Baseline.

Rollup Baseline data to Summary tasks on a selective basis 

By default, after the initial baseline is saved, a summary task’s baseline is not updated when a subtask is modified, added or deleted. There are now two new options in the Save Baseline dialog that allow you to choose when summary task baseline information is refreshed when saving a baseline for selected tasks. The options are: “Rollup baseline to all summary tasks” and “Rollup baseline from subtasks into selected summary task(s)”. 
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The first option allows baseline data from the immediate summary task to rollup into its ancestor summary tasks. The second option forces Microsoft Project to rollup the baseline details from its own sub tasks.
Update Project 

When you select to “Reschedule uncompleted work to start after” (Tools – Tracking – Update Project), tasks which have constraints but have no progress are not rescheduled. This is new behavior in Microsoft Project 2002. This is an improvement over Microsoft Project 2000 removing constraints on tasks and scheduling the tasks into the future as it gives more control to the project manager to decide what should be done with tasks that have constraints. A second improvement has been made to allow you to set the date for when you would like the uncompleted work to start in order to be more flexible. You can select any date as long as it is after a tasks existing Stop Date (when work stopped) or Actual Start date. This feature is available when you select Tools, then select Tracking and click on Update Project. 
Calculation Options 

New options are available that allow you to use the Status Date to determine on what date actual data is applied to a task and where the remaining work for that task is scheduled. Selecting the Tools menu, clicking Options, and then clicking the Calculations tab can access the options. The options are:

1. Move end of completed task parts after status date back to status date.

a. And move start of remaining parts back to status date.

2. Move start of remaining parts before status date forward to status date.

a. And move end of completed parts forward to status date.

Option 1a is not available unless option 1 is selected. Likewise, option 2a is not available if option 2 has not been selected. If Status Date is NA (not set) then the Current Date is used. To find the Status Date and Current date fields, select the Project menu and click Project Information. Constraints on tasks are ignored if these options are selected; actual start always overrides a constraint. The options are not applied when actuals are set on Summary tasks. These options only apply when making total actual value edits such as: Task total actual work, task actual duration, total % complete and % work complete. For example, if timesheet actuals are sent via Microsoft Project Server the options do not apply. However, if Percent Work Complete is sent then the options do apply.

Here is an example of how the first pair of options works:

· The Status Date is 5/9 (8:00 am is the default time).

· You have a task with a start date of 5/14 and duration of 4 days.

· The task’s Actual Start is 5/7.

· If option 1 is enabled then the task start is moved to 5/7, the percent complete is 50% and the remaining work is scheduled for 5/16, creating a split in the task.

· If option 1a is enabled then the task start is moved to 5/7, the percent complete is 50% and the start of the remaining work is changed to 5/9.


Here is an example of how the second pair of options works:


· The status Date is 5/9 (8:00 am is the default time).

· You have a task with a start date of 5/1 and duration of 4 days.

· If option 2 is enabled then the task actual start remains at 5/1, the percent complete is 50% and the remaining work is schedule to start on 5/9, creating a split in the task.

· If option 2a is enabled then the task actual start is moved to 5/7, the percent complete is 50% and the remaining work is scheduled to start on 5/9.

Below is a snapshot of the Calculations tab where you can find these options:
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Earned Value additional fields and calculation options 

Microsoft Project adds a new field, Physical % Complete. With the addition of this new field, you have a new option to choose either Physical % Complete or % Complete to calculate Baseline Cost of Work Performed (BCWP) on a per task basis. The difference between the two fields is that % Complete is based on Task actual duration divided by total duration whereas Physical % Complete is not tied to work or duration. It is your estimate of where the progress of a task lies regardless of actual work or time. Physical % Complete is calculated for Summary tasks by rolling up BCWP on subtasks to the BCWP on the Summary task. The Physical % Complete on a Summary task is applied to assignment data or Fixed Cost assigned specifically to the Summary task. 
Additional earned value Task fields will be added to Task tables and are listed below:

	Field Name
	Calculation
	Table Field
	TASK Timephased Field

	Physical %Complete 
	NA
	Yes
	No

	CPI (Cost Performance Index)
	BCWP/ACWP
	Yes
	Yes

	SPI (Schedule Performance Index)
	BCWP/BCWS
	Yes
	Yes

	CV%
	(CV/BCWP) * 100
	Yes
	Yes

	SV% 
	(SV/BCWS) * 100
	Yes
	Yes

	EAC ( Estimate at Completion)
	ACWP + (BAC-BCWP)/CPI
	Yes
	No

	TCPI (To Complete Performance Index)
	(BAC – BCWP)/(EAC – ACWP)
	Yes
	No


With the introduction of multiple baselines, you will now have the option to choose which baseline you want to use for earned value calculations.

To set the default method for earned value and set which baseline to use for earned value calculations:

1. Select the Tools menu, select Options, and click the Calculation tab.

2. Click the Earned Value button.

3. Click the dropdown list for “Default earned value method” and select either Physical % Complete or % Complete

4. Select a baseline. The last saved date for the baseline is also displayed.

To set the method per task:

1. Double click the task name to bring up the Task Information dialog and go to the Advanced tab.

2. Select a method from the dropdown list next to Earned value method.

Backward compatibility is supported in that a Microsoft Project 2002 project can be opened in Microsoft Project 2000 and none of the new earned value fields will display, but earned value will be calculated using % Complete and Baseline (0). The same project can be opened in Microsoft Project 2002 and the new earned value fields are once again displayed, no data is lost.
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Microsoft Project Server Pages display in Microsoft Project 

This feature has been added so that Program Managers can view related information from Microsoft Project Server in Microsoft Project without having to switch between two application windows. In the side-pane you can click on a link to Microsoft Project Server and information is automatically filtered for the open project and displayed in Microsoft Project. If you have a connection to a Microsoft Project Server, the following Microsoft Project Server views may be available for you to display in Microsoft Project. From the Collaborate menu: Update Project Progress, Project Center, Resource Center, Portfolio Analyzer, Portfolio Modeler, Documents, and Issues
Collaborate Menu 

This menu replaces the Workgroup submenu under the Tools menu in Microsoft Project 2000. This new menu and new commands make using Microsoft Project Server easier because it is more intuitive and requires fewer steps to accomplish specific goals.
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Publish - contains a submenu of commands. The commands and their functionality are listed below:

All Information – will publish the project plan as well as the changed assignments in one step. 
New and Changed Assignments – This dialog allows you to send new task assignments as well as changes to task assignments.

Project Plan… - This command copies the project plan to the Microsoft Project Server where it can be used for project views.

Republish Assignments… - This option allows you to resynchronize the server with Microsoft Project.

Here is the Publish New and Changed Assignments dialog:
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· “Publish new and changed assignment for:” dropdown list includes: Entire project, Current view (as in a filtered or collapsed view), and Selected items. The Selected items refer to those tasks you have selected prior to getting to the dialog box.
· You can choose to group by Resource or Task.
· “Notify all affected resources via email” if selected sends an email notification to resources, even if they have deselected this option in Microsoft Project Server. 
· Edit message text allows you to review and modify the email message sent to your resources.

· The Start and Finish dates are for the assignment and not the task; this is an improvement over Microsoft Project 2000.

Project Plan -This command posts project to Microsoft Project Server and you can choose between posting just summary info for the project plan or the full project plan. A second database to store project plans to is no longer needed. This menu item brings up the following dialog: 
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Republish Assignments… - This command replaces “Resend all messages” and includes two new options. Here is the dialog:
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· “Overwrite any actual work entered by resources” if checked, this sends assignments to Microsoft Project Server and overwrites the original assignment. If not checked, the assignment information is sent to Microsoft Project Server but leaves any actuals that are already recorded. 
· “Become the manager for these assignments” allows you to take over as manger for selected tasks. This option is discussed in more detail in the Multiple Project Manager Support section of this document. 

On the main Collaborate menu are these additional “publishing” commands:

Request Progress Information - This option sends a notification to resources requesting a task update and replaces the TeamStatus option in Microsoft Project 2000. Here’s the “Request Project Information” dialog:
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· Since this is a special request, resources are sent an email message.  You can modify the message using the “Edit message text” button. 
· This command also allows you to select the time period for which you are requesting

Updates Project Progress - This option displays an Update page from Microsoft Project Server and allows you to accept and reject task and calendar updates from resources. The Updates page is discussed in detail in the Microsoft Project Server section under Updates section on the Home page.

Microsoft Project Server Toolbar

In addition to the new menu there is a corresponding toolbar with buttons that correspond to all of the menu items on the Collaborate menu.
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Assignment dialog 

This dialog has been changed to support new functionality. Here’s the new Assign Resources dialog:

[image: image22.png][Assign Resources. [21x]
Task: Construction

| Resource st options ————————————————
by

7

Resources from Test Save by Admisrator Publshed —————

[ b colies B |
Resourcetane ™[RI [UEs

¥ lcapenter o lioow
[ [Congrete. | i1 e
© voe o

I o o, _Pese

Graphs

= + : Close.

o] __tek

Hold down Ctrl and clck to select multple resources

dddil





· “Task:” This control shows the name of the currently selected task. If multiple tasks are selected in the task sheet, then the message reads “Multiple tasks selected” and lists the task IDs for the tasks you’ve selected.

· The button to the left of “Resource List options” shows or hides the filter information when clicked.

· When “Filter” is checked, the dropdown is enabled as well as the “More Filters” button. The dropdown lists all resource filters. 

· The “More Filters” button, displays the “More Filters” dialog box and if the user creates a new filter, it is immediately available in the Filter by: dropdown list.

· When “Available to work” is checked, the remaining available hours for the duration of the selected task for each resource is calculated and compared with the number in the dialog. Resources with available hours equal to or greater than the value selected is shown in the list along with the resources already assigned to the selected task. “Available to work” is calculated as follows: 


For each resource, the Calendar and Availability contour is known. The duration for the selected task is known. Based on the resource’s calendar, the number of working hours for the resource on the selected task is calculated. However, the Availability contour may increase or decrease the number of working hours, and availability is further reduced by concurrent assignments for the resource on the same days. Therefore, the available working hours are multiplied by the availability contour numbers and then the existing assignment work is subtracted. In this fashion, you see the total remaining available hours for each resource.
 

For example, a task starts at day 1 and finishes at day 12. Days 6 and 7 are the weekend and day 8 is a holiday in the Project calendar, hence the duration is only 9 days. If the resource were to be assigned to this task, it would span 72 hours of working time. But say the resource’s availability contour is set to 50%, thus this is reduced to 36 hours. If it’s already assigned 50% on day 1 and 2 (8h total), total remaining hours available is only 28h. 

· When both filter options are selected, then the resources displayed must meet the criteria of both filters.

· A new field R/D has been added to this dialog and to Project. It allows you to set the priority for the use of a specific resource in preparation for using the Resource Substitution Wizard (more on wizard in the Resource Substitution section of this document). The values for this field are Demand and Request, Demand being the higher priority. The R/D field is disabled for material or generic resources.

· The command buttons for Assign, Remove and Replace function as they did in Project 2000.

· The Add Resources button allows you to add resources to the resource list. There are a number of options that allow you to retrieve resource names. These options are determined by your environment; they are Active Directory, Address Book, and Microsoft Project Server:


· Active Directory: Click this option and you can search for users or groups to add as resources to your project plan.

· Address Book: Click this option and your Exchange Address Book is displayed and you can select resource for your project plan.

· Microsoft Project Server: The Import Microsoft Project Server Resources dialog appears where you can choose from existing Microsoft Project Server resources. 


· Recently added resources are shown in the list, even if they don’t comply with any of the filter conditions. However the filters will no longer be available as they are only partly active once the new resources are added.

· The Graphs button brings up a dialog that allows you to choose what kind of information and for which resource(s) the graph is displayed. This assists you in selecting the best resource for your task. The resource information to choose from is Remaining Availability, Work and Assignment Work. The legend at the right indicates which data line corresponds with each resource; un-checking the resource removes the resource data form the graph. Here’s the Graphs dialog showing Assignment Work.
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You can select the graph to display the following types of detail:

Remaining Availability - one data series for each resource’s availability.
 

Work - one data series for each resource’s work.
 

· A vertical scroll bar displays as needed when there is more information in the data rows than can be displayed in the dialog. Horizontal scroll bars will display so you can scroll through the timescale. 

· The data comes from the resources’ time phased Work and Remaining Availability.

Assignment Work - This graph allows you to see if the current assignment is pushing the resources over their availability limit. It shows the total workload for the resources assigned to the selected task and the total availability of the selected resources. The bars are divided between the workload from the currently selected task (even if the Apply button hasn’t been clicked yet) and the workload from the rest of the project and other projects. If the selection contains multiple resources, their values are consolidated into one data series. This graph also has checkboxes for each resource in the selection, which allows you to see just the values for one resource as well.

 

Generic Resources 

Generic resources are a new type of resource added to Microsoft Project. Generic resources support skill-based resource assignment and replacement by allowing you to define and save frequently used skill/code profiles (specific values for one or more enterprise resource fields). They are handled much like work resources except that since they are not actual resources you can not create a Microsoft Project Server account or send them assignments via Microsoft Project Server. Generic resources can be stored in the Enterprise Resource pool or locally. If stored in the Enterprise Resource pool then you need permissions (set in Microsoft Project Server) in order to Open or Save the pool as well as permissions to add, edit or delete generic resources. A new field, Generic, has been added to indicate when a resource is generic; the values are Yes and No. In the Resource Information dialog box on the General tab, you can also choose to make a resource generic.

Enterprise Resources 

This provides a single repository for all enterprise resources used with a Microsoft Project Server. Resource records and summary resource assignments are stored in the enterprise database. The enterprise resources use the base calendars and enterprise resource fields defined in the Enterprise Global template. Microsoft Project opens enterprise resources when the user opens an enterprise project or when the user checks out one or more resources. When you open an enterprise project, only those resources that are assigned in the opened project are listed in the resource sheet. Resource sharing is turned off; if more resources are needed then you need to add the resources to your project (the Build Team from Enterprise facility can be used for this). On Save, the resource information in your enterprise project is updated with the most current data and summary resource assignments from the enterprise resources.

These resources are stored in the Enterprise Resource pool for the purpose of managing them centrally. The resources must be checked-out in order for their properties to be edited. Once resources are checked-out, the resources may be assigned to tasks in one or more projects in the enterprise database. While resources are checked-out other users can view the information but cannot edit their properties. At check-in, the resource records are updated in the Enterprise Resource pool. Permissions for you to add, edit and delete these resources is set up by the Microsoft Project Server Administrator and check-out and check-in operations are secured through Microsoft Project Server. 
To access these resources:

1. Click the Tools menu, select Enterprise Options and click Open Enterprise Resource Pool.
2. Once Microsoft Project Server has verified your permission to view resource information, the Open Enterprise Resources dialog is displayed. The dialog box lists all of the resources with a visual indicator specifying whether the resource can be opened read-only vs. read-write (checked-out) as well as whether the resource is currently checked-out by another user.
3. You can choose to filter the list of resources by selecting enterprise fields from a dropdown list of defined fields. 

4. Select the resources you wish to checkout by clicking the checkbox to the left of the name.

5. Click Open

6. Your permissions to checkout a resource is verified by Microsoft Project Server. Once verified, Project opens a temporary project called Checked-out Enterprise Resources.
Edits can be made to resources while in read-only mode but the changes are not saved. On save, modified data is validated against the Enterprise Resource pool for such things as unique names, use of enterprise base calendar, mandatory enterprise code values, etc. This process saves changes, sets the check-in timestamp and stores the name of last person who had the enterprise resource checked out.


Importing Resources into the Enterprise Resource Pool - Projects and Resources are imported separately; imported projects include their resources and assignments but do not create resources in the enterprise pool. If you want to import both, import resources before importing projects that use them so that you can use the resource matching capabilities of Import Projects (Tools | Enterprise Options | Import Project to Enterprise… to start the import wizard). The steps in the Wizard are:

1. Open a project(s) from which you want to import resources. Select a project from the database and click Open or if you wish to open a file from outside the database, click the Open from file button. Select your file and proceed.

2. Map local fields to enterprise fields; some fields are required.

3. Resources are sorted by unmatched/matched, then by resource name. Unmatched resources that have valid values for base calendar and mandatory fields will already be checked ready for import. 
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4. Use the Edit Resources button to correct any information that is invalid or missing. Errors appear in red. This may be used, for example, to edit a name so that it is not a duplicate of a name of an existing enterprise resource, or edit any other data available in this dialog. Any edits are made to the resource in memory, the source file is unaffected, and has already been closed at this stage.
5. Click OK and return to the Import dialog

6. Click Next and then Finish.

Saving Enterprise Resources – When you Save, the enterprise resources are checked-in, but must be validated first similar to the Import Wizard. Invalid resources are displayed in a dialog, which highlights any invalid data. This dialog is only presented if there are errors that you need to fix. Resources with valid data are saved immediately. 
Note that data validation on new resources is carried out before assigning an Enterprise Unique ID (EUID) but the name is not reserved. Another user could take the name while you are making changes to invalid data, the resource could become a duplicate on next presentation. The Save command can be used if the project is an enterprise project, Save Offline is used when you want to take the project offline. 


Enterprise Global template
This is a secure global file (similar to the Global.mpt file) that resides on the Microsoft Project Server. Administrators will have the only rights to make changes to the Enterprise Global. The Global stores standardized data for the corporation, all the same items (views, tables, filters, etc) as in previous versions for Microsoft Project global, with the addition of enterprise fields. When you launch Microsoft Project and you are connected to the Microsoft Project Server, the Enterprise Global template loads into memory and caches all calendars for use in any project that is opened during your session. Enterprise Global template items are copied into the project upon demand. You see both the enterprise items and your local items as long as the names are not duplicated. If duplicates are found, you are given the chance to rename your local items. When the project is saved, enterprise items are not saved in the project plan, however if you wish to work offline, the enterprise items are copied into you project plan. 
Modify Enterprise Global template - To modify the Enterprise Global template from within Microsoft Project select the Tools menu, select Enterprise Options and click Open Enterprise Global. If you are connected to the server and you have the proper permissions the Enterprise Global will open in Microsoft Project for you to edit. When you are finished making your changes, you can save the Global, which checks it back into the enterprise database. 
Enterprise Custom Fields 

These are custom fields stored in the Enterprise Global template to enable standardization across your corporation. When you open an enterprise project or create a new one, the enterprise fields are copied to the project and available for use. Only those with special permissions can add, edit and delete enterprise fields by checking-out the Enterprise Global template. Once the enterprise global is checked-out, go to the Tools menu and select Customize and click Enterprise Fields. The enterprise custom field editor is similar to the local custom field editor. In this dialog there is a new field type Project along with Task and Resource. There is also a tab to allow you to work with enterprise outline codes:
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Import Custom Fields … - this allows you to import one custom field at a time that exist in an enterprise global file.

1. Choose the field name from the initial Customize Fields dialog. 

2. Click Define Code Mask to define values for the lookup table values. 

3. Finally the lookup table values can be input via the “Edit Lookup Table” button.

Enterprise attributes – These features allow you to:


· Share another code’s Lookup Table - this option has been added for efficiency and to reduce data input. When defining a new code just select which code’s Lookup Table to link to.

· Only allow selection of codes with no subordinate values – This requires that the highest level of detail be selected for the field value. For example, if you are using an outline code for location, the first level may be country, then state and lastly city. The final value selected for this field would need to be at the city level.

· Make this field required – for enterprise projects this field must have a valid value before it can be published to the Microsoft Project Server.

All Lookup Table values must be defined beforehand via the Custom Enterprise Fields Editor and cannot be added ad-hoc into views. When entering a value into a cell, it must be either selected from the dropdown, or the exact name of an existing code must be entered. If an undefined name is used, an error is displayed.

Formulas – Enterprise project plans can have local formulas referencing Enterprise Fields but enterprise formulae cannot reference local custom fields as their contents cannot be assured. Trying to include such a reference generates an alert.

Clearing a Definition – The definition of an Enterprise Custom Field can be cleared by setting all the options back to their default values including clearing the renaming. A quicker alternative is to delete the code through the Organizer. The consequence for users who may have tables etc. that include the deleted enterprise field:

1. On opening the project, all references to the Field are removed from the project. 

2. The field is no longer available in dialogs that offer fields, such as Insert Column.

Outline Codes used by the Resource Substitution Wizard - An important piece of the new enterprise functionality is the Resource Substitution Wizard feature (more information later in this doc). Basically, the substitution wizard allows you to perform “skill substitution.” For example, you might want a VB programmer for a certain task. Instead of assigning an actual programmer, you can specify a skill code for VB users through the new Assign Resources dialog, and then use the Resource Substitution Wizard on the project. The Resource Substitution Wizard searches for an available VB user and substitutes her/him in with the task. 
When creating an Enterprise Resource Outline Code, there is a checkbox to indicate the code is to be used to match on generic resources. 

Information dialogs – A tab for Custom Fields has been added to Task, Resource and Project information dialogs that indicates both required fields and optional fields defined.


Offline support for enterprise items – This feature allows you to use enterprise data when not connected to the Microsoft Project Server. 

Creating a new Custom Outline Code involves these steps.


1. Click the Custom Outline Codes tab

2. Choose the field name. 

3. Click Define Code Mask to define values for the lookup table values. 

4. Finally, the lookup table values can be input via the “Edit Lookup Table” button.

Resource Substitution Wizard

The Resource Substitution Wizard provides you with the ability to assign and replace resources based on the skill demands of tasks in one or more projects, the resources’ skills and the resources. The wizard enables you to very rapidly develop models of resource staffing across a collection of projects and aids you in configuring the wizard to assign resources and save results in a project version.

To use the Resource Substitution Wizard you need to be connected to a Microsoft Project Server. To start it, from the Tools menu, click Substitute Resources. Here are the Resource Substitution Wizard steps and the tasks performed:

The Welcome page – describes the steps in preparing the wizard.
Choose Projects page – Step 1: – allows you to specify which of the projects open in Microsoft Project should be considered by the wizard. This page allows you to perform the following tasks:

· View the projects to be scheduled by the wizard.

· Remove opened projects from being scheduled by the wizard.
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Choose Resources Page – Step 2: The Resources page allows you to specify the resources to be considered by the wizard when rescheduling the selected project/s. You can choose from (a) the resources in the projects selected in the Context page, (b) the resources at or below a specific level in the Resource Breakdown Structure, and (c) any combination of resources within the enterprise resource pool. This page allows you to perform the following tasks:


· Select the resources to be considered by the wizard.

· Identify selected resources that do not have values specified for skill codes.

· Specify the resource freeze horizon – the wizard only considers assignments made after this date.
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If you click the Add button the Team Build from Enterprise dialog is displayed and new or additional resources can be added to the list of available resources for the wizard.

Choose Related Projects Page – Step 3: The Context page allows you to select the projects to be included in the substitution wizard. This page uses wizard’s context navigation functionality to identify projects associated with the open project through cross-project links or shared resources. This feature enables you to perform the following tasks:


· View the projects directly and indirectly related to the selected project(s).

· Specify the projects to be rescheduled with the selected project

The wizard only schedules projects with the same version. When searching for related projects, the wizard looks for projects with the following relationships to those projects selected in the “Projects” page:

· Projects targeted by cross-project links in the “selected” projects. 

· Projects that include assignments using resources selected in the Resources page. 

Assign Resources Page – Step 4: This page allows you to specify how the wizard should reschedule the projects selected in the Projects and Context pages and the scheduling options allow you to control how the wizard reassigns resources for each project. This page allows you to perform the following tasks:

· Set the priority of each project. The wizard assigns available resources to projects from highest to lowest priority project.

· Set the scheduling options for each project. The wizard can reschedule a project by using only those resources in a project or using resources in the pool defined in the wizard. This enables you to map project or organizational constraints (e.g., I cannot change assignments for an in-progress project but have flexibility for a proposed project) onto the wizard.

· The wizard respects all supported Microsoft Project application and project-level scheduling options.
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Configuration Page - Step 5: This page allows you to run given the specified projects, resources, assignments, and resource freeze horizon. You are provided status feedback while it is running and can cancel. 
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Results Page - Step 6: Once the wizard has completed, it displays any assignments it has changed. This page allows you to perform the following tasks:


· View the results of the re-engineering of the selected projects.

· Return to the beginning of the wizard to modify the wizard’s settings.

· Navigate to the Versions/Update page.
Choose Update Options Page - Step 7: This page allows you to save the results of the resource substitution. Updating the projects included in the wizard can save results. This page enables you to perform the following task:


· Specify that the projects included in the project be opened and have the results of the wizard applied to them.
Finish Page Step 8 - This page reports progress on the selected version/update operations and provides reminders. This page enables you to Stop updates to projects or save new versions of projects.

While the Resource Substitution Wizard can update the resources used in each project in Microsoft Project’s memory you may need to perform two additional actions to reflect the impact of the resource substitutions in their project plans: 

1. Level the project plans using Microsoft Project’s leveling feature.

2. Save the projects to the Microsoft Project Server or a local MPP file. The wizard performs neither of these operations. 
Build Team from Enterprise 

This feature is available from within Microsoft Project and is used to select resources from the enterprise resource pool before or after a project plan is built. Or it can be used to replace resources currently assigned in a project plan. The only major requirement is that you are connected to the Microsoft Project Server so that you have access to the enterprise resource pool and your permissions to view resources can be validated. The Microsoft Project Server administrator will have already set your permissions. 


To start Build Team from Enterprise:


1. Go to the Tools menu and select Build Team from Enterprise. This option is not available if you are offline, or in a read only project.

2. If there are greater than 1000 resources in the enterprise pool to which you have permission to view, then a Pre-filter dialog will automatically display. This is to maximize project performance.

· You need to either select an existing filter or create a customized filter in the dialog. The filters are based on enterprise custom outline code fields created by the Microsoft Project Server Administrator on the server. The filter always uses the equal operator and Project inserts an “And” between any additional criteria lines, which means the data will be an intersection of all stated criteria.

3. If the number of resources matching the criteria is still over 1000 then the pre-filter dialog displays a second time. You can either add additional criteria to further refine the data or just click OK and all the resources display. If zero resources are returned then an alert lets you know that no resources meet your criteria. 

4. On the server side a resource view is created, a connection string returned and enterprise resources are loaded into your open project plan. The resources returned are listed in the left hand side of the dialog.
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Existing Filters: - This dropdown list contains all available filters.

Customize filter (optional) - This section is collapsed when you first come into the Build Team from Enterprise dialog. Clicking the plus + button expands this section and exposes the filter grid for building your filter. There are also row editing tools and Apply Filter and Save Filter buttons are also available.

“Work required” - The “Work required” filter is always available with or without any filters being applied. This filter searches through the non-material resources returned from the resource global and selects resources with remaining availability equal to or greater than the number entered for “Work required” value between the dates specified. Use the fields From: and To: to specify when the resources are needed. The dates default to the project start and finish dates.


Group by: - Enterprise resources can be grouped by enterprise custom outline fields to assist in selecting your team.


Project Team resources: - This is a list of any resources already defined in the project plan. Enterprise resources are the expected default, so no indicator is shown for these resources. Generic resources are identified with a blue “head” icon and local resources with a green icon.

Sort – Resources can be sorted by clicking on the header row.

Add – This button appends the selected enterprise resource to the project team.
Remove – This removes the selected member from the project team only if the resource has no assignments.
Replace – You must have one project team resource selected and one enterprise resource selected to use this button. Replace is different from the Add command. Replace takes on the old assignments of the resource you are replacing.

Match – This button is used to find enterprise resources that meet the criteria you specify in one of the three following ways. 


· Select a generic resource from the right then click the match button. A custom filter is built automatically, from the enterprise custom outline code fields used to define the generic resource itself. 
· Selecting an existing filter

· Editing or creating a custom filter.


Use the Replace button once you select an enterprise resource from the filter results.

Graphs… – Click Graphs to see the resource availability graphs. Click Details to get more information on the selected resource.

Details … – Click the Details button to get resource information.

Versions 

 Project versions build a foundation to offer functionality such as: 


· Full comparison between versions that includes added/deleted tasks and assignments, constraints and other changes not saved in baselines.

· Trend analysis between snapshots taken at regular intervals.

· A sand pit area to try what-if scenarios, separate from the current or published version.


There are not multiple versions of resources – the enterprise resource global holds only one version of resources with their availabilities, calendars etc. However, assignments in projects, including the project summary assignments reflect the version of the project to which they belong.


The administrator for Microsoft Project Server predefines available versions. Once versions are set up, you can then copy your project into a version or said another way, save your project plan as a version. The first version is the default system version, labeled Published, which maps into Microsoft Project Server. For example, timesheets only show assignments from the published system version. Because of its importance and the necessity for it to exist, the “published” version is protected and is setup as part of initial configuration. Additional versions of a project can be viewed in the Open file dialog in Microsoft Project or in the Project Center view of Microsoft Project Server.


To define versions:


1. As the Microsoft Project Server Administrator, log on to Microsoft Project Server.

2. Click the Admin tab and select Manage Enterprise Features and from the Enterprise Options list, select Versions.


Adding a version requires you to supply a name and decide if this will be an archive version. Archive project versions when opened will not be updated with active Enterprise Global template or enterprise resource pool data, but contain snapshot data from the time of the save.

Deleting a version requires that no project plans are currently saved to that version type. An alert will display if project plans exist. You cannot delete the default or published version type. The administrator can format versions for easy recognition. To do this:


1. Click the Admin tab and click Customize Microsoft Project Web Access.

2. Click Gantt Chart Formats.

3. Choose an existing bar group name such as Gantt1; format things the way you wish. Click Save Changes.

4. From the Admin page, click Manage Enterprise Features. Click Versions.

5. For the particular version, modify it to change the Gantt Bar Name field to match the one you modified in step 3.


In addition to the bar type names, Project Summary Version 1-5 have been added. When viewing different versions you can Sort, Group and Filter by version type.

If you are connected to the Microsoft Project Server, when you save a project plan for the first time you will be prompted for a name and version. Internally the project name and version are stored together separated by a period. This aids in backward compatibility as well as keeping project names unique to the system. Saving a version overwrites any information already saved as that version. To save a different version type, click Save As and select new version.
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When you open a project while connected to the server you will receive this dialog:
[image: image32.wmf] 


While the Read/write radio button is selected project names are grayed out that are checked-out. Click the radio button next to Read-only and all projects are available.

Cross Project links need to be between project files of the same version type. If not then the links will exist in the file as static links that will not update. 
Open Project with Orphaned Links - If links are orphaned for any reason, (for example you elect to save a single project as described above) this can be resolved on the next open of the project. As in earlier releases of Microsoft Project a dialog displays that allows you to browse for broken links. When you resolve a link, any other links to the same project get resolved as well.

Portfolio Modeling 

This feature adds the ability to interactively model changes to projects or resource staffing and view the impact of the changes on a project portfolio. The models can be saved and then compared.

Portfolio Models Page – This page is the “portal” page for the portfolio modeling features in Microsoft Project. Listed are all your existing models, allowing the models to be viewed in detail, edited, or deleted. The Portfolio Model page enables the following tasks: New, Modify, Delete, Open and Analyze.
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If you select a Model and click Open the following page displays:
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The Modeler page displays projects in a Microsoft Project Server grid with a Chart providing details on the resources assigned to the projects. Gantt bars use a color code to identify the degree to which project resources are overallocated by time-phase. This is a single model view, however multiple models can be compared in this page as well. The Portfolio Modeler page enables the following tasks: Modify, Analyze compare, open the Toolbox, Zoom in and out.

Modify Model – The key to portfolio modeling is the ability to interactively change a model’s settings and view the results. The portfolio model may be modified through two user interfaces: Model property Toolbox and the Modify Model page. The Model property allows you to view and change a subset of the model’s settings. This user interface can be used to perform a relatively rapid set of interactive settings. You can view the toolbox and the Modeler page simultaneously. 

Model Property Toolbox
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The Modify Model page displays all the model’s settings. However, you cannot view the Modify Model page while viewing the Modeler page. These features enable the following tasks:


· View the settings of a model

· Add/remove the projects in a model

· Change the scope of the model’s resource pool (fixed within a project, fixed within a model, fixed within a Resource Breakdown Structure level)

· Change the scheduling options of a model, including: overtime, resource reassignment, criteria (duration, cost, resource allocation)


There are three steps to the Modify Model option that are displayed below:


Modify Model – Projects and Resources Page
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Modify Model – Context Page

[image: image37.png]Portfolio Modeler

Include related projects.

In the orid below, choose the related projects you want to include in this model, and
then click Next to go to the Scheduling Options page.

Model name and description

Name: Foundations.
Description:

Scheduling Context: Specify the related projects to include in this model:





Modify Model – Scheduling Options Page
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New Model Page - You can create new models from the Models page by choosing the New pushbutton/link. The New Model page provides the same fields, options, and layout as the Modify Model pages shown above. 

Compare Models Page - As you modify models, you are likely to want to compare the results of one model against another. For example, you may want to compare the results of a model allowing overtime vs. a model that does not allow overtime. The Compare Models page allows you to specify the models to be displayed in the Portfolio Modeler page. 
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The resulting Portfolio Modeler view adds an additional column (Model) to the table, groups the projects by Project and then adds the projects from the specified models. By default, the Portfolio Modeler includes the selected model and a Resource Substitution recommended model. The Compare Models page enables you to specify or change the models displayed in the Portfolio Modeler page.

Analysis - The Analysis page provides textual and graphical details regarding resource utilization and process constraints of a model. The page also includes recommendations on staffing the projects within a model. This feature allows viewing summary statistics and graphs regarding the assignments and scheduling of the projects in a model and saving or printing the scheduling options used in a model.


The elements of the Analysis page include:

· Summary statistics of model 

· Cumulative resource utilization graph

· Schedule options used in the model

Summary Statistics
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Resource Utilization Graph
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Scheduling Options Report
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Portfolio Analyzer 

The Portfolio Analyzer View provides executives and functional managers easy access to detailed information about their projects and resources. In addition, this feature also allows fast and powerful analysis capabilities to users right from Microsoft Project Server. The technology that Microsoft Project utilizes to present views are Microsoft SQL Server 2000 Analysis Services to generate an OLAP cube for querying data tables and then stores the information in an XML blob for presentation and loading into the controls on the Portfolio Analysis page. 
There is a choice between three modes in which an Analyzer view can be defined; PivotTable, Chart and a combination of both. The PivotTable control provides users with a sheet view of the data, whereas the Chart control shows a graphical representation. In both these formats, you can leverage the interactivity of the Office Web Components (OWC) in analyzing high-level project and resource information. The Administrator must first create an OLAP cube before they can define the Vision view. The view must be bound to the cube in order for the administrator to see what fields of information are available for creating the view. 
OLAP Cube Generation - Microsoft Project uses the technology of MOLAP (Multidimensional OLAP) cube using Microsoft SQL Server 2000 Analysis Services. Below are the details on the process used to build the cube as well as the admin functionality exposed to allow the administrator to control certain aspects of cube generation. To access this page:


1. Logon to Microsoft Project Server through Project Web Access as Administrator and click the Admin tab.

2. Select the link to “Manage Enterprise Features” and in the side-pane, click “Update resource tables and OLAP cube.”

3. Build the OLAP cube. Options are Yes and No, select the radio button for Yes.

4. OLAP server. The server name is the name of the server where SQL Server 2000 Analysis Services is installed. This is a required field.

5. Cube name. Enter any descriptive name. This is a required field.
6. Cube description. This is an optional field. The description only displays on the SQL Server 2000 Analysis Services.

7. Date range for cube. This is a required field; it determines the time period used when extracting data for the cube. There are three options.

· Use the earliest project start date and the latest project finish date. Microsoft Project will calculate the earliest and latest finish dates for all assignments and use those dates whenever the cube is generated or updated.

· Use the following date range at the time the cube is built. You supply the number and unit for which the date range will span. This information is used when the cube is generated or updated.

· Use the fixed date range specified below. You supply the dates for cube generation. You will need to modify the dates whenever you update the cube.

8. Date range for resource availability. This is a required field regardless of cube generation. There are two options.

· Use the following date range for retrieving resource availability information. You enter the number and units.

· Use the fixed date range specified below. You enter the dates From and To.

9. Update frequency. There are two options,

· Update every (number and units). 

· Start updating starts on <date> and <time>. The cube is updated automatically starting from this date and then at the time interval specified in the field above.

· Update only when specified Update Now button. 
Resource Center View 

This view is essentially a view of the enterprise resource pool available in Microsoft Project Server. The Resources Center view is comprised of the following features:

1. Resource list with capability to group using various outline fields.

2. Edits to some resource-level properties (such as Location, Department, Skills etc.) 

3. View Availability/Usage graphs for a resource or multiple resources. 

4. View team information for resource(s).
The Microsoft Project Server administrator creates, edits and modifies resource views and sets permissions for users to see various resource views as with project, project center, assignment, resource center and portfolio analyzer views. To setup resource views:


1. Log on to Microsoft Project Server as Administrator and click the Admin tab.

2. Select the Manage Views link on the left side-pane.

3. Select a resource view to modify and click Modify View or click New View.


Whether you choose modify or new, the user interface is the same, except that Modify View is the title of the page and some information is already populated. When defining a new view: 


4. Click the radio button next to Resource.

5. Enter a Name for the view, Description is optional

6. Select the fields in the left that you wish to see displayed in the view, click Add button to move them to the right.

7. Optionally, specify a filter, Group by and Sort by fields.

8. Most importantly, select categories on the left to enable permission to see the view, click the Add button to move the categories to the right.


[image: image43.wmf] 

 


To access the view in Microsoft Project Server, log on to Microsoft Project Server as a resource manager and click the Resource menu. The page exposes a variety of functionality including, editing resource information, filtering, grouping, resource availability graphs and opening a resource or group of resources in Microsoft Project. Here is a sample of what the page looks like:
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You must have the proper permissions set by the administrator in order to modify resource information. If you select a resource and click Edit resource details your permissions are checked and verified. If the resource has already been checked-out by someone else then an alert displays letting you know, otherwise a new page is displayed where you can edit the resource.

[image: image45.png]Home | Tasks | proje

3 Microsoft Project

Web Access

Resource Details : G.C. Concrete Crew

Activities in Resources:

View enterprise resources in
Resource Center

Analyze resources in Portfolio
Analyzer

View resource assignments

| & Save and Close | Go backto Resource Center |

Resource Fields Value

Resource Education - |
Resource Position - |
Resource Skl - |




All custom fields that show as graphical indicators will not display on this page. When you have finished editing the resource, click Save and Close. The resource is checked-in to the enterprise resource global and you will return to the previous resource view page.  

Back on the resource view page the command Open allows you to select one or more resources and choose to open the resource in Microsoft Project. If you have applied a group, you can select the group summary to select all resources in the group. When you select this button, the resources are checked out, and opened in a project in Microsoft Project. If this process fails, perhaps because one or more resources are already checked out, an error message displays that tells you the operation failed because one or more resources are already checked out. The Open button only appears if Microsoft Project is installed on your machine.

Resource Availability Graph 

The graphs can be accessed through the Resource View in Microsoft Project Server or through the Assign Resource dialog in Microsoft Project. You are able to choose one or more of the resources and view their availability. The Resource Availability graph enables the following tasks:

· Viewing the time-phased assignment work of one or more resources

· Viewing the time-phased availability and remaining availability of one or more resources

· Viewing time-phased data grouped by project


The last view persists if you navigate away from this page. When the view type is changed, the timescale and selected resources remain the same. The condition of the table, whether it is collapsed or expanded also persists. The default reporting period can be edited and the timescale units can be zoomed in or out. If you have permission to view the resource then you can view all the projects in which that resource is assigned regardless of your permissions to view specific project files. The graphs do have a limit of 200 data points; however, the reporting period should work around this.

The resource availability tables used to create the graphs will be updated for a date range specified by the Microsoft Project Server Administrator. This is done when the OLAP cube is generated (information on this was presented in an earlier section). 


Microsoft Project Server Accounts 

All enterprise features are dependent on Microsoft Project’s connection with a Microsoft Project Server; each Project Server provides access to a different set of enterprise projects and resources. As organizations deploy Microsoft Project 2002, project managers may need to interact with multiple Microsoft Project servers as well as needing a method for running Microsoft Project in an offline mode. 

You can define one or more Microsoft Project Server Accounts. When you launch Microsoft Project, you can choose the desired server account or choose to run Microsoft Project offline. 
The Project Server Accounts dialog box can be accessed by:


1. Starting Microsoft Project Professional 2002. 
2. Selecting a connection from the list of servers.

3. Clicking the Connect button. The Enterprise Global template is opened from the server identified in the profile and the enterprise features are enabled, based on your permissions to that server.


You can also choose to Work Offline, which uses a local cached version of the Enterprise Global template. Or choose Cancel, which dismisses the dialog.
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To setup project server connections, from the Tools menu, click Enterprise Options and select Microsoft Project Server Accounts.
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Add - To create a profile:


1. Click the Add button

2. Enter a name for your account.

3. Enter the URL for the Microsoft Project Server site in the form of http://<server_name>/<virtual directory name>. You can click the Check button to verify the URL you’ve entered. If there is a problem connecting to the URL an alert displays with details about the error.

4. Choose a radio button for account access to the server -- either Windows User or Microsoft Project Server account. If a Microsoft Project Server account is selected then enter you user name.

5. If you wish this account to be your default for Microsoft Project startup then select the Set default account checkbox.


Properties - In this dialog you can select an account name and then click properties to edit details about the account. 
Remove - You can also choose to delete the account by selecting an account name and click Remove.

Set as Default – You can set which account Microsoft Project should use on startup by selecting the account name and clicking the Set as Default button.

When starting – You have a choice to automatically detect connection state. Microsoft Project will connect to the server indicated by the account on startup. Or you can choose to manually control the connection on startup. This causes the first dialog Microsoft Project Server to display on startup.

Microsoft Project Server login from Microsoft Project 

In order to display information from Microsoft Project Server, Microsoft Project needs to be able to authenticate users against Microsoft Project Server security. If users are using a Microsoft Project Server User account, a dialog with Microsoft Project Server login displays within Microsoft Project. If users are using a Windows user account, the authentication happens transparently, so no dialog displays. The dialog may also appear if you try to access an enterprise feature and you: 


· Have launched Microsoft Project without using an account or chosen to work offline.

· Have launched Microsoft Project and the server account information isn’t correct.

· Have lost your connection with the Microsoft Project Server for whatever reason.

· You normally log onto the server using a Microsoft Project Server account.


Multiple Manager Support 

Microsoft Project 2002 supports more than one manager in a number of different scenarios by eliminating the dependency on the project manager name to uniquely identify a project published to Microsoft Project Server. What makes a project plan unique is the project name and the project creation timestamp. It is very common for Project Managers to use a completed project plan to create a new one, which means that the Project Name and Timestamp will be the same as a project already published to Microsoft Project Server. In such a case Microsoft Project 2002 displays an alert if this conflict exists, and you’ve selected any of the following commands: 

· Publish All

· Publish assignments

· Publish summary information

· Resend all assignments


The alert asks you if the project location has been changed and if you would like to update this information to Microsoft Project Server or if it is a new project. This eliminates duplicate copies of the same project plan in Microsoft Project Server. 

An email address field specifically for the Project Manager has been added. This ensures that notifications about assignment updates are sent to the correct manager. To enter the program manager’s email address, go to the Tools menu and select Options, then click the Collaboration tab.

To make support of multiple managers possible:


· You become a Project Manager of an assignment by publishing an assignment for a task, not by publishing the project plan. 

· You can take over the Project Manager responsibility on assignments by selecting to Republish Assignments on selected assignments and checking the option “Become the manager on these assignments”.


· You can only view and process resource updates on the assignments for which you are a manager.

Backward Compatibility 

Microsoft Project 2002 keeps the "same" file format as Microsoft Project 2000. This means that you can save a file from Microsoft Project 2002, load the file into Microsoft Project 2000, make changes, save the file again, and load it back into Microsoft Project 2002. There will be references (features) in Microsoft Project 2002 that Microsoft Project 2000 cannot understand; those references remain hidden in the file. In general, Microsoft Project 2002 information is retained. However if changes are made in Microsoft Project 2000 and the file then is opened again in Microsoft Project 2002, changes made in Microsoft Project 2002 will overwrite any changes made in Microsoft Project 2000. 

If you choose the option to Save As in Microsoft Project 2000, Microsoft Project 2002 changes are lost and you will receive a warning message to let you know.

Microsoft Project 98 files can be read in Microsoft Project 2002 and SaveAs Microsoft Project 98 is supported in Microsoft Project 2002.

Forward Compatibility 

Looking toward the future, Microsoft Project 2002 has a way of handling unknown data fields from newer versions of Microsoft Project. Instead of hiding unknown data fields as in backward compatibility, Microsoft Project 2002 will display “unavailable” or NA for data coming from a later version. So for example, if a new field is added to a table then the column title will be Unavailable and the data will have N/A. A new filter based on an unknown field will cause a standard warning to display, “The <filter name> could not be found”, the same for grouping and sorting.

Office Watson 

If for some reason Microsoft Project were to stop responding or encounter a fatal error, you now have the opportunity to send the details of the issue to the Microsoft Project development team. A dialog displays with the option to restart Microsoft Project and view details of the error report. There are also two buttons one to Send the report to Microsoft and one that says Don’t Send. If the error is something that Microsoft Project can recover from, Safe Mode will automatically evoke so that you can continue working in Microsoft Project.

Microsoft Project Server

Microsoft Project Server Compatibility 

This enables you to upgrade your servers to Microsoft Project Server 2002 and still allow users with Microsoft Project 2000 or Microsoft Project 2002 to access the server. Or visa-versa, you could choose to upgrade your workstations to Microsoft Project 2002 and then upgrade the Microsoft Project Server after the workstation upgrades are finished.

Microsoft Project Server Scalability 

Microsoft Project Server 2002 will meet the performance and scalability needs of large organizations containing hundreds of projects and thousands of resources. You can choose to install all components of Microsoft Project Server to one machine or you can install the Microsoft Project Server on a dedicated web server with a separate server used for the Microsoft Project Server database and so forth. You can then use load balancing for your web servers and clusters for your database server. All projects are stored in the Project Server database. 
New Look for Microsoft Project Server 

The general appearance of the user interface has the look and feel of other Microsoft web applications such as SharePoint Team Services. The primary focuses of the changes are on the menu structure to accommodate all the new features, improving usability and simplifying the individual pages. There are no dropdown menus in Microsoft Project Server. Instead there is a set of ‘tabs’ across the top for the main functional areas, and an Actions Pane on the left to navigate within the pages in a particular area. 


The Microsoft Project Server Administrator can “turn off” some of the options in the Actions Pane based on user permissions in groups. There are also several default groups that include:


· Team Members – A team member is automatically assigned to this group when they are sent an assignment.

· Project Managers – If you publish assignments to Microsoft Project Server you are added to this group.

· Executives

· Resource Managers

· Administrators
· Team Leads

· Portfolio Managers


You can belong to multiple groups. The menu items and items in the Actions Pane that you see are determined by taking the union of items visible for you as an individual user and items visible for all the groups you belong to.

 

By default, there are some menu items that are visible only to Team Members (such as the Tasks menu item). Project Managers and members of other groups won’t see these items until they receive a workgroup message/status report request that automatically causes them to get added to the Resources group.

 

Microsoft Project Server Home page – The Microsoft Project Server Home Page is cleaner and less cluttered than the previous version, and matches the look and style of other Microsoft web applications. The information displayed on the Home page are items that are relevant to the current session, such as items that may have changed since your last login, and items that need action taken. Depending on which user group you belong to, you see a different home page on login. 
Here is an example of an Administrator’s Home page:

[image: image48.png]EMicrosoft Project
Web Access Home

Welcome to Microsoft Project Web Access,

Activities in Home: Administrator

Home Page

Change password Updates

Set my e-mail notifications and
reminders.

You have no changes to update into Microsoft Project.

Set e-mail reminders for my | Tasks
Go offiine B2, You have no new tasks assigned to you. Subscribe to receive e-
mal notifications when
items change.
Status Reports
Upcoming status reports to submit: Dizplay Micrescft Project
D) Foundations Weekly Status Report  Due on 11/9/2001  Outiook .

or display a digital

Issues dashboard in Outlook ...

You have no active issues assigned to you.

Use the tabs across the top and the links on the left to navigate through
Microsoft Project Web Access.




Updates - When resources update tasks, delegate tasks, make changes to their calendars, etc. these updates are displayed in this section. If there are no updates then the text states that no updates are pending. This replaces the Messages section from the pervious version.

Tasks - There is a section for Tasks that may be assigned to you. No tasks are assigned in this example. This replaces the Messages section from the pervious version.

Status Reports - If no status reports are pending, this section is not displayed on the page. This was a tab in the pervious version.

Issues - This is a new section; if there are issues pending for your review they are displayed with a red issue indicator when action is needed, green for resolved and yellow for in progress. Issue tracking is discussed in greater detail in this document.

Updates Section on the Home page 

This section on the Home page replaces the Messages section in the previous version of Microsoft Project Central. You must have security permissions to “Manage Task Changes” and “Manage Calendar changes” in order to see the Update section. These security settings are contained within Security Templates that in turn are applied to Users. The Project Manger group has these security settings enabled by default. However if you need to add these permissions for a user the Microsoft Project Server administrator can set them by following these steps:

1. Log on to Microsoft Project Server as Administrator

2. Click the Admin Tab and select Manage Security. This brings up the Categories page.

3. Click “Security Templates” and choose the Add Template link to create a new set of permissions, or select an existing template and click the link Modify template.

4. In the Permissions grid, scroll down to the transactions section and click the Allow check box next to “Manage Task Changes” and “Manage Calendar changes”.

5. Click the OK button

Once the template is set then the template must be applied to the user account.


1. Click the Admin tab

2. Click the link “Manage Users and Groups”.

3. Select the user account and click the link “Modify User”

4. In the Categories section, under permissions, select the dropdown list next to Set Permissions with Template, select the template you created or modified in the steps above.

5. Click Save Changes button at the top of the page.

You can get to the Update page in two ways; click on the Updates link on the home page or click on the Update Tab across the top of the Home page. If you have updates to tasks, a message displays letting you know how many changes you have. If you have updates to calendar information the message displays on a second line with the number of changes. 


There are four links to other pages that can be accessed from the Update page. They are:


· Update task changes submitted by resources into Microsoft Project.

· Update changes to resources calendars into Microsoft Project.

· Set Rules for automatically accepting changes.

· View History of past task changes.

Update changes to tasks – This page lists any task updates, new tasks created by team members, task delegation requests, and declined resource tasks. You can select an update in the grid and set the new Accept field to accept, reject or set to blank. You can come back and deal with the blanks at another time. Once you have marked the items then click the Update button and the project plan/s are updated in Microsoft Project. You can also mark group summary tasks and summary tasks as Accept or Reject and the child tasks inherit the setting. If a resource were to send multiple updates on a single task only the latest update is displayed.


View Options – This option allows you to show time with dates, Summary Rollups and show summary tasks. You can also change the time period for which you would like to view updates; by default the period begins with the earliest date from any pending updates. You can also adjust the timescale; the default is in days.

Filter and Group - You can also filter and group in this view to help you organize updates quickly. There are predefined filters to choose from or you can create a custom filter. Grouping defaults to by project, Then by task change type and finally by resource name. There are a handful of other fields in the dropdown that are relevant to grouping in this grid. 
Apply Rules – This option applies the rules that have been set for automatically accepting updates into Microsoft Project on a per project basis. There is a link in this section that takes you to the Manage Rules page.


Accept all – This option marks all updates with accept.


View History – This option takes you to another page where you can review previous updates that have been accepted.


Insert Notes – This option adds notes to the selected updates task.

Update Changes to resource calendars into Microsoft Project – Selecting this link takes you to a page similar to the Update changes to tasks page, with the same options available.

You can also mark group summary tasks and summary tasks as Accept or Reject and the child tasks will inherit the setting. 

Here are some general rules for what you should expect in the Update page:


· If a resource were to send multiple updates on a single task only the latest update displays. 
· If a resource delegates a task, one row is displayed in the update list. If the team member rejects the delegation then that is on a separate row and the Accept field is not editable because the two updates negate each other.

· Values that have changed since the last update are highlighted in red to alert you to the new info. Microsoft Project Server keeps track of which data has not yet been accepted into the project plan in order assure that you updates aren’t lost. 
· The tracking mode of the pending updates determines whether to display a Timesheet or a Gantt View. If specific hours are used for any update, then a timesheet displayed; otherwise a Gantt Chart view. 
· If you reject an update for whatever reason then the team member that sent the update is notified.

· Microsoft Project must be installed on the machine to accept the updates. If Microsoft Project is not running then it is automatically launched and a connection to the Microsoft Project Server is made so that updates to enterprise project plans can be done. The enterprise project is checked out automatically but you have to check in the project plan when you are finished with it. Project plans stored on the local machine are updated without a need to connect to the server. If any updates cannot be completed then an alert is displayed. 
· Updates are processed in the following order:

1. Delegation updates (include rejected delegations)

2. New task updates

3. Task updates

4. Rejected assignments

· Once an update is completed successfully the record is moved to the History page. Any updates that were left blank are pending and remain on the Update page until they are either accepted or rejected. Highlighted data is no longer highlighted and a flag to remind you to save the project plan is displayed until the changes have been saved. Also after a successful update the team member’s timesheet are updated so that the “pending for manager update” indicator is turned off.


Set Rules for Automatically Accepting Changes – You must have permission to set update rules. If you do not have the proper permission then the Rule tab does not display. The process for setting rules has not changed from the previous version. However, only those names of resources with permissions to “Send Updates” and “Delegate Tasks” are available when creating rules. Rules take precedence; a rule may override the accept setting in the updates grid if the rule is satisfied. Rules are not applied until you select the “Run rules now” button.

View History of Changes to Tasks – This page holds all accepted and rejected updates. Filter, Group and Sort are all available commands in this view. The history is kept up to 60 days. 


Comments Field 

This field is available for editing by team members and is included in updates to the Project Manager. The “Notes” field is a multi-line plain text field. All text is kept until you intentionally delete it. The text in the “Notes” field becomes read-only as soon as an update to Microsoft Project occurs on the assignment. The field has also been added to the Update history record. The current note is appended to the given task’s notes, so the Project Manager does not end up with repeated comments in the Task notes field.

View Improvements 

In Microsoft Project Server when you navigate away from a view such as a Portfolio or Assignment view, the settings that you selected will persist, so when you come back to the view it looks the same as when you left it. You can also save the view in its modified state as a link in the side-pane.  Click the “Save link in side-pane…” button to save a link to the view. When the button is clicked a dialog displays where you can enter a name for the link. The name of the link defaults to the name of the view. If you are in a Project view then the name defaults to the name of the project plan followed by a colon and the name of the view, i.e. <Project name>: <view name>. The side-pane with your links also displays on the Home page for quick access to your views.

Notifications 

In Microsoft Project Server a general SMTP email notification system can be used instead of one that’s tied to MAPI e-mail clients as in Microsoft Project 2000. An email notification is generated based a wide range of user initiated events. Basically, every time there is a change in the information for managers and resources, they can receive an email describing the changes, such as project name, task details and hyperlinks to the appropriate section in Microsoft Project Server. There are action driven email notifications and email reminders. Microsoft Project Server users are able to see their own reminders. Managers can set reminders for their resources.

Both email notifications and reminders are in the left pane of “Home” page section.


· Set My Reminders and Notifications

· Set Reminders for My Resources. 


If you do not have the “Set Reminders for Resources” permission, you will not see this link. The Microsoft Project Server administrator sets the permissions either through groups, categories or permission templates. Each user is able to subscribe to the notifications by checking on or off the events in Microsoft Project Server.

To see the broad range of actions that generate e-mail notifications, in log onto the Microsoft Project Server using Microsoft Project Web Access and from the Home page, click the Set my E-Mail Notifications and Reminders link.

The following rejection actions automatically trigger a notification. 
1. Rejected Assignments by resource

2. Rejected task updates (by manager)

3. Rejected new tasks (by manager)

4. Rejected calendar updates (by manager)

5. Rejected task delegation requests (by manager)

6. Removed from a status report (by manager)

Subscribing to notifications – You can subscribe to the set of action driven notifications that you want to receive in e-mail, this way you control the amount of e-mail you receive. Subscribing to notifications also solves a problem for the project manager in trying to decide who should receive which notifications. Subscriptions are available to you based on permissions set up by the Microsoft Project Server Administrator. 
Below is a snapshot of the page that will display when you select to Set My E-mail Notifications and Reminders on the Home page.
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Reminders – A daily scan of the database determines all of the events you will need to be reminded of. Only the Microsoft Project Server administrator can set the time when the notification scan is run each day. Note that this is different from the set of action driven email notifications mentioned above. These notifications are about existing events, and can be recurring. 
Reminders are a per-user setting in Microsoft Project Server for all tasks, status reports and issues you own. The scanning process batches the notifications by person and by data type and sends only 3 emails per user per day. Each user can set their own reminders on their own tasks, status reports and issues.  A manager can also set reminders for resources that have assignments in the manager’s projects. Likewise, a resource can turn off their own settings but cannot turn off a manager’s settings. 

Below is the other half of the page that displays when you select to Set My E-mail Notifications and Reminders on the Home page.
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The Microsoft Project Server Administrator can customize email notifications and reminders using these steps:


1. Log on to Microsoft Project Server as Administrator and click the Admin tab

2. Under Customize Microsoft Project Web Access, select Notifications and Reminders.

The following page appears:
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Sender Address - This address replaces the “From” in all notifications emails. You may want to put your own support email alias in, so your users can reply to the email and ask for help.

Company Email Address - For any email notification to work properly, an administrator must ensure the proper email address of a resource. SMTP emails require full email address, such as user@microsoft.com. The company e-mail address will be your domain name.
Default E-Mail Message – This field is so your company can add its own information to the end of the standard email message.

Here is an example of an email message:
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Microsoft Project still supports MAPI workgroup messages as in previous versions.

Popup Spooler alerts 

When errors occur during an attempt to update information to the Microsoft Project Server an alert displays asking if you want to look in the spooler for more information. 
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If you choose yes, you see the spooler where more information is given:
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The message type tells you what action in Microsoft Project was done, the error tells you about the problem and the other fields give additional detail. You have the option to retry or undo the action. A spooler icon will display in the system tray.

Timesheet Improvements 

To navigate to the timesheet you can click the Tasks link on your Home page or select the Tasks tab. The goal of the improvements is to present a cleaner less clustered page and to add features to make the page more useful and intuitive. The first change has to do with the Tracking method used to report progress on tasks. The Microsoft Project Server Administrator can set a default method by which all projects are tracked and can also choose to lock down the method. If the method is not locked down then the Project Manager can override the default setup by the administrator to best suit the current projects being worked. 
The Microsoft Project Server administrator also sets the default reporting period. The reporting period can be changed by the resource, assuming the administrator has not locked this option down.

The Administrator also sets the maximum number of hours that can be entered per day. This does not restrict the resource from entering more hours; it is used in the Project Manager’s Update page to identify tasks that have a high labor amount.

A new filter “Current Tasks” has been added to the timesheet so that completed tasks or tasks far in the future do not show in the timesheet while this filter is applied. Again the Microsoft Project Server Administrator sets how far in the future this filter extends.

Also available in the timesheet are grouping capabilities and status indicators on tasks.

Tracking method - There are 3 choices for Tracking Mode:

1. Percentage of Work Complete

2. Actual and Remaining Work

3. Hours of work done per Day or Week

If the Microsoft Project Server Administrator locks down the tracking method after projects have already started to be tracked then the Project Manager will have to change the tracking method in his project plan. An error message will display in Microsoft Project if the Project Manager tries to publish a project plan and the tracking method does not match. 
To set the tracking method, Lock down, max hours and reporting time period for Microsoft Project Server follow these steps:


1. Log on to Microsoft Project Server as Administrator and click the Admin tab

2. Select Customize Microsoft Project Web Access from the side-pane. Click the Tracking Settings customization option.

3. Select a Tracking method under the section “Specify the default method for reporting progress on tasks.”

4. In the section “Lock down defaults” choose Allow… or Force …

5. In the section “Time Period Settings” choose the frequency

6. Select a radio button for how the resources will enter actual work. Every day of reporting period, total for the week, or total for the reporting period.

7. Enter the maximum number of hours that can be entered per day

8. Under the Define Current Tasks, enter the number of days to view into the future.

9. Click Save Changes.

Here is a snapshot of the Microsoft Project Server web page “Tracking Settings”:
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The Project Manager can override the default setting set by the Administrator as long as the Administrator did not choose the option to Force project managers to use the progress reporting method specified above for all projects. To override default settings follow these steps:


1. Open your project plan in Microsoft Project.

2. From the Tools menu select Customize and then click Published Fields.

3. Select a radio button next to the tracking method you would like to use.

4. Select any additional fields of information you would like to have display in the Microsoft Project Server timesheet (only the fields listed next to the tracking method will be editable.

5. Track overtime work (this allows the resource to specify how much of the actual work was during overtime)

6. If you do not want resource to be able to delegate tasks then deselect the checkbox
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Before this dialog can be displayed the connection with Microsoft Project Server is checked so that the default tracking method can be found and displayed. If the connection cannot be made then an error message displays. The tracking method is updated to the Microsoft Project Server so that your resources’ timesheets display the correct fields for tracking progress.

It is entirely possible for a resource to have assignments from different projects, using different tracking methods. In the case of a resource having assignments using all 3 tracking modes, all the editable fields for each method are viewable in the timesheet. However the resource is only able to edit the fields as set in each project. 
If a Project Manager changes the tracking method after actuals on tasks have already been reported, the task’s tracking method will not change. Any tasks that have not started or are added will change to the new method.

Selectively Update Tasks 
The timesheet has new command buttons, Update Selected Rows, Update All and Reject. 

Update Selected Rows – You can select a specific row or record from the timesheet, make changes to the record and then click the button. Only those rows within the selection will be sent for updating.

Update All – sends only those rows that have been changed.

Reject – this command lets you reject tasks that have been directly assigned by a program manager or a task delegated to you. You cannot reject:


· Tasks that have actuals reported on them.

· Tasks that are part of a task list, not part of a project plan.

· Tasks that are from Outlook or are non-project time 

· A task that is a tracking copy of a delegated task

· A new task that has not yet been updated by the Project Manager

· If this option has been turned off by the Project Manager


If you select a summary or a group summary task and then click the Reject button it is assumed that you wish to reject all the subtasks under the summary. Only those tasks that meet the criteria listed above are rejected. A dialog displays letting you know how many and what kind of tasks have been rejected. There is a Show Details button that lists any tasks not rejected and an explanation as to why. Once a task is rejected it is removed from the timesheet. Rejected tasks show up in the Project Manager’s Update page for action and an email notification will also be sent out. If you reject a delegated task then email is sent to the lead that delegated the task.

Here is a picture of the dialog:
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Updates to Actuals 

A resource can potentially modify actuals for a task on any day, and the changes will be sent to the Project Manager for updating. The “show timescale period” in the toolbar is used to improve the performance in the timesheet but the dates can be changed so that actuals can be entered. Microsoft Project Server Updates page highlights modified task actuals, so the Project Manager can immediately capture the changes and proceed to update the project plan. To support this feature, a “dirty” flag is set on each actual cell in the usage view, each cell in the custom fields, and each cell in the “Remaining Work” and “% Work Complete” fields.  


· A cell is flagged “dirty” if the data in the cell has been changed since the last update into Microsoft Project. 
· A cell is clear if the data in the cell has not been changed since last update into Microsoft Project.

· A dirty cell is reset to clear once data in this cell has been updated to Project.


If a resource re-enters actual data outside the range specified by the manager, then this is flagged in the mangers update page


Grid Controls 

Views of project information in Microsoft Project Server rely primarily on the Microsoft Project Server grid control. The grid control supports displays of both tables and time-phased bar charts. Incremental improvements have been made to the grid control including:


· Display of splits in the Gantt view – This feature works as it does in Microsoft Project 2000 today.

· Support for multiple hierarchies in grouping – This feature allows for three levels of grouping with in Microsoft Project Server views. Also, two additional levels for a total of five levels for grouping.

· Phased Portfolio Rollup views – This feature allows the Administrator to create bar styles that can then be rolled up to the summary level as you can do in Microsoft Project.

· Additional auto filter conditions – Two additional operators for setting up custom filter criteria have been added. They are “contains” and “begins with”.

· Search capabilities – You can now search for a value while in a Microsoft Project Server view. You can also select which field to look in for the matching value.

· Pick Lists in Custom Fields – If a value list was created for a custom field in Microsoft Project Server then a pick list displays in the cell when selected. Options set in Microsoft Project determine if new values can be added to the pick list or not. Formulas cannot be edited for custom fields in Microsoft Project Server.


Task Delegation 

If you select a summary task then all the subtasks are selected and marked for delegation. If any of the tasks in the selection cannot be delegated an alert displays informing you that some of the tasks cannot be delegated and would you like to continue. If you choose Yes then you can proceed to delegate the remaining tasks. Selecting the Show Details button lists the tasks that cannot be delegated along with the reasons why. The reasons a task cannot be delegated are:


· This task is a tracking copy of a delegated task
· Actual work has been entered for this task and the manager’s approval is pending.  

· A resource created this task, and the manager’s approval is pending.

· This task is a nonworking time entry.

· The manager has removed this task.

· Your manager has specified that tasks in this project cannot be delegated to a different resource.


Two notifications are sent out when a task is delegated. The first notification goes to the resource that you delegated the task to and the other to the project manager to use in updating the resource information in the project plan.

If the project manager rejects the delegation then notification is sent to the resource that the task was delegated to and to you to let you know that you are still responsible for the task. Likewise, if the resource rejects the delegation then you and the project manager are notified.

You can also choose to delegate the Lead role on the task as well. In this case three notifications are sent out. The first notification goes to the resource that you wish to assume the Lead role, the second to the resource who was delegated the task and last to the project manager. The Lead can request task status on delegated tasks and one notification is sent to the resource that was delegated the task.

Microsoft Project Server To-Do Task List

This feature has been added to allow users to start a to-do task list in Microsoft Project Server. The task list can be managed in Microsoft Project Server or can be loaded into Microsoft Project and managed as a true project plan, utilizing Microsoft Project’s scheduling engine. 
You can access this feature by clicking the Projects tab and selecting the “Create a new personal or shared to-do list” link. Give the Task list a name and specify who can view the list, click the next button. You are then taken to the Tasks tab and the Create Tasks page is displayed where you can enter tasks. Tasks assigned to resources are immediately viewable on the resources Task page; there is no need to publish assignments because the tasks are created in Microsoft Project Server. Resources can update progress, reject or delegate Task List tasks. 

To manage the task list, return to the Projects tab and click the link on the side-pane for Manage my to-do list or To-do list options. You can transfer the task list to another user or convert the task list into a project plan.

The task list is stored in Microsoft Project Server as project tasks but with a few differences. Since there is no scheduling engine in Microsoft Project Server here is a list of the differences between a published project plan and a To-do task list.


· You cannot edit work or duration. You can only change the start and end dates. Internally, work and duration are set to zero for all task list tasks.

· Tasks may be assigned to only one resource at 100% units. No delegation of To-do list tasks is allowed, however the Project Manager can reassign the task.

· Resources can only report status as percent complete, not actual work or remaining work.

· Tracking progress – if a task is 50% and then the end date changes the task remains 50% complete.

· Nonworking days and sick leave are ignored for resources. Individual resource calendars are also ignored.

To-do task lists do:


· Show up in views and other areas you would expect to work with a Project

· Support single assignments (one resource on one task) 

· Have the “Fixed” Duration task type.

· Support resources reporting the status of their tasks


To-do task lists DO NOT:


· Support outlining

· Support dependencies (all tasks have fixed start/end dates)

· Support constraints

· Support calendars

· Support variable duration tasks (i.e. no “work”)

· Leveling, baselines, material resources

SharePoint Team Services Integration 

SharePoint Team Services (STS) is used to attach supporting documentation to project plans and for Issue tracking. Before document library and issue tracking can work properly for Microsoft Project Server users, Microsoft Project Server must be aware of the STS server. For each project in Microsoft Project Server, when the project plan is first published, a sub-web is created in STS for that project. Microsoft Project Server automatically adds resources associated with the project plan to its respective STS sub-web if the users are using Windows Logon accounts. In order for users of Microsoft Project Server to have access to Documents and Issues tab, the Microsoft Project Server Administrator must set permissions on the application level. Those permissions are “Link Documents” and “Link Issues”. Users with permission to “View Projects in drilled-down views”, “View documents and issues”, and/or “Save project” will be able to use the features of the document and issues tab.

Because SharePoint Team Services relies on both the file system and data in the database to track information about your Web site, you must be sure to keep these systems synchronized. A Microsoft Project Server organization maps to a single virtual STS server site. Each project in Microsoft Project Server maps to a sub-web on the site. For Microsoft Project Server purposes, the sub-webs do not inherit permissions from the site. An STS web contains multiple lists, such as events, discussions, documents, and tasks. Microsoft Project Server uses a custom list for storing issues and documents. Once SharePoint and Microsoft Project Server are set up you can navigate directly to the SharePoint site. You would see a custom list called Issues the Microsoft Project Server created. You can interact with the issue list; however, you lose the ability to link issues to projects, tasks, and documents. 
An STS “public” sub-web is automatically created when a new project is added to Microsoft Project Server. Also created is the Microsoft Project Server document library and Microsoft Project Server issue list. To accomplish this Microsoft Project Server must customize the STS server-side web and list template. Microsoft Project Server also uses customized copies of ASP pages from STS to fit the feature set of Microsoft Project Server, so if Microsoft Project Server is removed from the system then the original templates are still available for STS to use.

When you log in to Microsoft Project Server using a Windows account, you are automatically logged into an STS session. Microsoft Project Server provisions a public sub-web named MS_ProjectServer_PublicDocuments when STS is setup. The Administrator can point this sub-web to any STS server. Anonymous browsing is setup by default and a custom role called Microsoft Project Server is created based on the Advanced Author role in STS. This role gives Microsoft Project Server the rights to:


· Author pages

· Browse pages

· Design lists

· Author lists

· View lists

· Close Web Document Discussions

· Author Web Document Discussions

· View Web Document Discussions

· Subscribe to Documents


Three other roles are created and users with these roles have rights to:


· Browser role – Browse, view lists, view discussions and subscribe

· Project Manager – all the rights in the above list

· Team Member – upload documents, create issues, edit and close issues.

The administrator can set creation of sub-webs to automatic or manual. If automatic is selected then a sub-web is created the first time assignments are published to Microsoft Project Server, the first time a project plan is published, when a Task List is converted to a project plan or the first time a project plan is checked-in. 

To set defaults for SharePoint Team Services:

1. Log into Microsoft Project Server as Administrator and click the Admin tab.
2. From the side-pane select Manage SharePoint Team Services and click Subweb provisioning settings.
3. Select the SharePoint server to create sub-webs on.
4. Choose automatic or manual sub-web creation.
5. Click the checkbox for automatic account addition to sub-web for Resources and for Project Managers.
6. Select which SharePoint server to use for public documents not associated with project plans. 
To manage existing sub-webs click the link in the side-pane called “Manage sub-webs”. In this section, the administrator should be able to view all sub-webs created for all the projects and task lists in Microsoft Project Server. The administrator can perform the following actions: 

1.   View the sub-web address for each project

2.   Navigate to the sub-web administration page

3.   Delete the sub-web link

4.   Rename the sub-web link

5.   Delete the sub-web

6.   Synchronize all users

Document Library 

This feature allows you to link supporting documents such as project justification, project feasibility analysis, and budget estimation, to a project plan, a task in a project plan or a task list. This feature enhances collaboration and the project management process. This is a Public document space where documents can be posted and shared across the organization. There is also a Project document space per project plan where documents specific to the project plan will be stored. Documents are “linked” to project plans based on the SharePoint sub-web being linked to the project plan.

If you click the Documents tab in Microsoft Project Server, you are presented with a page listing all the projects that you have read access to. When you click on a project link all of the document libraries display for that project plan (as illustrated in the following picture).
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A Project Manager can create multiple document libraries in the project document space; each document library acts like a one level file folder. To create a new document library click the “New document” button.
 

Clicking View and Upload Public Documents allows you to drill down into the document library and displays the page above. The commands available on this page are:


New Document – Clicking on this button opens the default document template in Microsoft Office XP, so you can create the document and save it back to the document library. If you do not have Microsoft Office XP, you will receive an alert. If the document library does not have any default template specified, Word will open up.

Upload document - Upload Document directs the user to the upload page, where the user copies the document into the SharePoint server.

Filter - Clicking on ‘Filter’ turns on the autofilter in the same page.
Subscribe – Clicking on ‘Subscribe’ redirects the user to Microsoft Project Server ‘Notification settings’ page.
Save a Link – This command has been added to every view in SharePoint, so you can save a link to the Microsoft Project Server side-pane of the default “Documents” page. The default name is the Document library name. Once you click OK, this link is added to the side-pane.

A user with advanced author rights can change what fields of information display on this page by going to “Modify settings and columns” link. A resource would not see this command by default.
Upload Documents page - You can also add documents directly in the document library by clicking “Upload documents”. The user is directed to the upload page:
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Link tasks – “Link the document to tasks” command when clicked displays a separate page with a list of project tasks that you can select.
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The Link Document command is also located on the timesheet and assignment views. If multiple tasks are selected when the link is preformed, the document will only be linked to the first task. If no task is selected the first task in the list gets the link. Links can only be made to tasks that have been approved by the Project Manager, copies of delegated tasks, and summary tasks.

Issues Tracking 

Issue tracking helps to improve the efficiency and effectiveness of project management by improving communication on project related issues. An issue is a collaborative document that typically has a business process that defines how the issue will be handled. You can create and edit issues as well as customize the fields that display and the view itself. Issues are created and managed in individual project plans or Task lists. Resources can create and edit issues, Project Managers can create, edit and customize, and all others have read only permissions. An issue can be associated with a project, a task in the project, and documents in the project’s document library or other issues within the same project. An issue can have three status states, Active, Closed and Postponed. Issue indicators showing the state of an issue can be seen in a timesheet view, assignment view, portfolio view, when you drill into a project plan and on the Issue tab in Microsoft Project Server. You can subscribe to email notifications that will alert you to the change in status for an issue.

If you have permission to view issues (at least “View Project Documents and Issues”), clicking the Issues tab in Microsoft Project Server displays the Issues Page. You see a list of projects and a tally of active, closed and postponed issues associated with each project. The Project Manager name and type of project also is displayed. You can only group on one level in this view, but you can sort and search. 
Click on a project name to view the issues associated with that file. Below is a snapshot of the default page layout:
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In the side-pane the links take you to various views of the issues. For example, “All of the issues owned by me.”
Across the top of the page are commands for:

New issue – takes you to a page where you can create a new issue.

Filter – toggles the autofilter.
Export – saves the issue to a file.
Subscribe – takes you to the page where you can subscribe to email notifications for issues.

Save a link – saves a link to the current view.

Modify settings and columns – If you have permission to “Design list” in SharePoint Team Services you see this item. By default, the project manager for a project is the only person who can define new views for issues and add additional columns for issues.
Following is snapshot of the New Issue page:
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Title – enter a title for the issue. This is a required field

Status – by default will be active.

Priority – the default priority is (2) Medium

Assigned to – the dropdown has a list of all the resources that have permission to this sub-web issues list. If a resource is assigned an issue but only has view permissions then the Microsoft Project Server Administrator needs to change the role in SharePoint Team Services to allow edit rights for the resource.

Issue Owner – this defaults to the account you signed on to Microsoft Project Server with. 

Due Date – The date when the issue needs to be finished.
Discussion – this is a cumulative text field. Microsoft Project Server appends the resource name and date each time text is added.

Resolution - A cumulative text field, behaving exactly like “Discussion”. Only 2 rows are shown for edit.

Affected Tasks – When you click on this link a dialog is displayed with a list of tasks. You select the tasks that will be affected by the issue you just created. 

 
You can filter on:

· All my tasks (task assigned to you)

· All project leaf tasks (subtasks, not summary tasks)

· All Summary tasks ( no subtasks)

· All published task in Microsoft Project Server

You can sort by double clicking a column heading.

The OK button links the tasks and the Cancel button closes the dialog without saving any changes.

Back on the View and Submit Issues page there are also links for:

· Select project tasks that help to resolve this issue. 

· Select project tasks that are generally related to this issue.

· Select other project issues that are related to this issue.
· Select project documents that are related to this issue. 

Double clicking an issue opens it in a details page. If you click the Edit Issue button on this page, another page similar to the View and Submit Issue page displays. Here you can add discussion notes, change the status on the issue or link additional items.

In a portfolio, timesheet or assignment view there is a button called Link Issues. Clicking this button takes you to a page called Issue List where you can add a new issue or remove task links to an issue. 

The Microsoft Project Server Home page displays a section called Issues if any new issues have been assigned to you.

In Microsoft Project under the Collaborate menu there is an Issues command that opens the Issues page from Microsoft Project Server. The Microsoft Project Server Administrator and the Project Manager with the right permissions can define additional views (STS functionality) for issues in a project. An authorized user sees “Modify Settings and Columns” in an issue list view. On this page, you can create new views, and change the view default. A new view is defined by specifying:

· What fields are visible in the list

· In what order

· Sort order of the list

· Filters applied

· Maximum number of items shown on the page 

Check-in and Check-out

In Microsoft Project Professional 2002, when connected to the enterprise server, you can save a project offline so that you can work on it and not worry about other users making changes to it. When you check-out a project, (File menu, Save Offline) a “hidden” copy is saved to your local hard drive. When you Save the project back Online the server’s copy of the project is changed to reflect your local copy and the project is then made available for other users to open and modify. In the meantime, other users, based on security permissions, can still view the project.

Microsoft Project Programmability

Project OLE DB

The Microsoft Project 2002 OLE-DB provider has been improved to provide the following project details:

· Calendar data

· Calendar exceptions

· Cost rates

· Custom fields

· Custom field graphical indicators

· Custom field value lists

· Custom outline code fields

· Resource availability

· Timescaled data – resource, task and assignment

· WBS

Dashboard View
The various pages in Microsoft Project Server have been modified so that you can easily include them in a dashboard view. Specifically, views, portfolio information, and status reports have been made into web-parts so that you can easily integrated them into an Outlook dashboard. On the flip side, the pages can now be displayed from within Microsoft Project. For example, if as the project manager you go to the Collaborate menu and click “Update Project Progress”, the Updates page appears in Microsoft Project where you can more easily see what changes are going to be applied.

Object Model/Event Additions

There have been several Object model and event additions to Microsoft Project 2002. Below are some of the additions. Note: Many new methods and properties have been added to support the new enterprise features. These are not listed here.
Views
View Object Represents a view in Microsoft Project. The View object is a member of the Views collection. The View property returns the View object.  This property applies to the Pane object.

	Methods:
	Delete Deletes the view. Returns nothing.
Apply Applies the view. Returns nothing.

	Properties:
	Application Returns an Application object. Read-only.
Name Returns or sets the name of the view. Read/write String.
Parent Returns the parent of the object.  Read-only Object.
ViewType Specifies whether the view is a task or resource view. The constant is one of PjItemType values. Read-only Long.
Single Specifies whether the view is a single view or a combination view. Read-only Boolean.
ShowInMenu Specifies if the view is shown in the View menu (True) or not (False). Read/write Boolean. 


Views Collection A collection of all the View objects. The GlobalViews property on the Application object returns a Views collection of views in global.mpt whereas the Views property on the project object returns a Views collection of views in the project file.

	Methods:
	Copy(View, NewName) Makes a copy of a view. Returns the new view. 
View Specifies the view to be copied. Required Object. 
NewName Specifies the name of the new view. Required String.

	Properties:
	Application Returns an Application object. Read-only.
Count Returns the number of items in the specified collection. Read-only Long.
Index Returns the index of an object in its containing collection. Read-only Long.
Item Returns a single item from a collection. Read-only Object.
Parent Returns the parent of the object. Read-only Object.


ViewSingle Object Represents a single-pane view in Project. The ViewSingle object is a member of the ViewsSingle collection.
ViewsSingle Collection A collection of all the View objects for single views. The GlobalViewsSingle property on the Application object returns a ViewsSingle collection of views in global.mpt whereas the ViewsSingle property on the project object returns a ViewsSingle collection of views in the project file.

ViewCombination Object Represents a combination view in Project. The ViewCombination object is a member of the ViewsCombination collection.

ViewsCombination Collection A collection of all the View objects for combination views.  The GlobalViewsCombination property on the Application object returns a ViewsCombination collection of views in global.mpt whereas the ViewsCombination property on the project object returns a ViewsCombination collection of views in the project file.

Tables
Table Object Represents a table in Microsoft Project. The Table object is a member of the Tables collection.

	Methods:
	Delete Deletes the table. Returns nothing.
Apply Applies the table to the current view. Returns nothing.

	Properties:
	Application Returns an Application object. Read-only.
Name Returns or sets the name of the table. Read/write String.
Parent Returns the parent of the object.  Read-only Object.
TableType Specifies whether the table is a task or resource table. The constant is one of PjItemType values. Read-only Long.
TableFields Specifies the TableFields collection for the table. Read-only Object.
DateFormat Specifies the format for the date fields in the table. Member of PjDateFormat. Read/write Long.
RowHeight Specifies the height of the rows in the table. Read/write Long.
LockFirstColumn Specifies if the first column of the table is locked (True) or not (False). Read/write Boolean.
AdjustHeaderRowHeight Specifies if the header row height should automatically adjust (True) or not (False). Read/write Boolean.
ShowInMenu Specifies if the table is shown in the View menu (True) or not (False). Read/write Boolean.


 
TaskTables Collection A collection of all the Table objects for tasks. The GlobalTaskTables property on the Application object returns a TaskTables collection of tables in global.mpt whereas the TaskTables property on the project object returns a TaskTables collection of views in the project file.


	Methods:
	Add(Name, Field, ShowInMenu) Adds a task table to the Tables collection. Returns a reference to the new object.
Name The name of the Table.  Required String.
Field Specifies the first field in the table. Member of PjFields. Required Long.
ShowInMenu Specifies if the table is shown in the View menu (True) or not (False). The default value is False. Optional Boolean. 
Copy(Table, NewName) Makes a copy of a table. Returns the new table. 
Table Specifies the table to be copied. Required Object. 
NewName Specifies the name of the new table. Required String.

	Properties:
	Application Returns an Application object. Read-only.
Count Returns the number of items in the specified collection. Read-only Long.
Index Returns the index of an object in its containing collection.  Read-only Long.
Item Returns a single item from a collection.  Read-only Object.
Parent Returns the parent of the object. Read-only Object.


ResourceTables Collection A collection of all the resource Table objects. The GlobalResourceTables property on the Application object returns a ResourceTables collection of tables in global.mpt whereas the ResourceTables property on the project object returns a ResourceTables collection of views in the project file.

	Methods:
	Add(Name, Field, ShowInMenu) Adds a resource table to the Tables collection. Returns a reference to the new object.
Name The name of the Table. Required String.
Field Specifies the first field in the table. Member of PjFields. Required Long.
ShowInMenu Specifies if the table is shown in the View menu (True) or not (False). The default value is False. Optional Boolean
Copy(Table, NewName) Makes a copy of a table. Returns the new table. 
Table Specifies the table to be copied. Required Object. 
NewName Specifies the name of the new table. Required String.

	Properties:
	Application Returns an Application object. Read-only.
Count Returns the number of items in the specified collection. Read-only Long.
Index Returns the index of an object in its containing collection.  Read-only Long.
Item Returns a single item from a collection.  Read-only Object.
Parent Returns the parent of the object. Read-only Object.


 TableField Object Represents a field in a table in Microsoft Project. The TableField object is a member of the TableFields collection.

	Methods:
	Delete Deletes the field from the table. Returns nothing.

	Properties:
	Application Returns an Application object. Read-only.
Field Specifies the Field in the table. Member of pjFields. Read/write Long.
Parent Returns the parent of the object.  Read-only Object.
AlignData Specifies how to align the text in the field. Member of pjAlignment. Read/write Long.
Width Specifies the width of the active columns, in characters. Read/write Long.
Title Specifies the title for the field. Read/write String.
AlignTitle Specifies how to align the title in the column heading. Member of PjAlignment. Read/write Long.
AutoWrap Specifies if the field should automatically adjust row height(True) or not (False). Read/write Boolean.


 
TableFields Collection A collection of all the TableField objects.  The TableFields property returns the TableFields collection.  This property applies to the Table object. 

	Methods:
	Add(Field, AlignData, Width, Title, AlignTitle, Before, AutoWrap) Adds a field to the TableFields collection. Returns a reference to the new object. 
Field The field in the table. Member of PjFields. Required Long. 
AlignData Specifies how to align the text in the field. Member of PjAlignment. Default is pjRight. Optional Long. 
Width Specifies the width of the active columns, in characters. Default is 10. Optional Long. 
Title Specifies the title for the field. The default value is Empty. Optional String. 
AlignTitle Specifies how to align the title in the column heading. Member of PjAlignment. Default is pjCenter. Optional Long. 
Before The position of the field in its containing collection. The default value is the position of the last item in the collection. Optional Long.
AutoWrap Specifies if the field should automatically adjust row height (True) or not (False). The default is True. Optional Boolean.

	Properties:
	Application Returns an Application object. Read-only.
Count Returns the number of items in the specified collection. Read-only Long.
Index Returns the index of an object in its containing collection.  Read-only Long.
Item Returns a single item from a collection.  Read-only Object.
Parent Returns the parent of the object. Read-only Object.


Filters
Filter Object Represents a filter in Project. The Filter object is a member of the Filters collection.

	Methods:
	Delete Deletes the filter. Returns nothing.
Apply(Highlight) Applies the filter to the current view. Returns nothing.
Highlight Specifies whether the filter should be applied as a highlight filter (True) or not (False). The default is False. Optional Boolean.

	Properties:
	Application Returns an Application object. Read-only.
Name Returns or sets the name of the filter. Read/write String.
Parent Returns the parent of the object.  Read-only Object.
FilterType Specifies whether the filter is a task or resource filter. The constant is one of PjItemType values. Read/write Long.
ShowRelatedSummaryRows Specifies if the filter shows the related summary rows or not. Read/write Boolean.
ShowInMenu 
Specifies if the filter is shown in the menu (True) or not (False). Read/write Boolean.


 

TaskFilters Collection A collection of all task Filter objects. The GlobalTaskFilters property on the Application object returns a TaskFilters collection of filters in global.mpt whereas the TaskFilters property on the project object returns a TaskFilters collection of filters in the project file.

	Methods:
	Copy(Filter, NewName) Makes a copy of the filter. Returns the new filter. 
Filter Specifies the filter to be copied. Required Object. 
NewName Specifies the name of the new filter. Required String.

	Properties:
	Application Returns an Application object. Read-only.
Count Returns the number of items in the specified collection. Read-only Long.
Index Returns the index of an object in its containing collection.  Read-only Long.
Item Returns a single item from a collection.  Read-only Object.
Parent Returns the parent of the object. Read-only Object.


 

ResourceFilters Collection A collection of all the ResourceFilter objects. The GlobalResourceFilters property on the Application object returns a ResourceFilters collection of filters in global.mpt whereas the ResourceFilters property on the project object returns a ResourceFilters collection of filters in the project file.

	Methods:
	Copy(Filter, NewName) Makes a copy of the filter. Returns the new filter. 
Filter Specifies the filter to be copied. Required Object. 
NewName Specifies the name of the new filter. Required String.

	Properties:
	Application Returns an Application object. Read-only.
Count Returns the number of items in the specified collection. Read-only Long.
Index Returns the index of an object in its containing collection.  Read-only Long.
Item Returns a single item from a collection.  Read-only Object.
Parent Returns the parent of the object. Read-only Object.


 
New Events
A new parameter has been added to the Microsoft Project events. It is called the EventInfo object. This object will be in lieu of the Cancel parameter that we used for events in Project 2000. The main reason for this object is because of the Project Guide – since only objects (as opposed to other field types such as Boolean etc) can be passed by reference in JScript. The EventObject has one property, namely Cancel, that is of type Boolean.

EventInfo Object Represents cancel information of the event object.

	Properties:
	Cancel Returns or sets the Cancel state for the event. False when the event occurs. If the event procedure sets this argument to True, the action that fired the event is cancelled. Read/write Boolean.


WindowSelectionChange. Occurs when the selection handle is changed within a project window.

Note: The event will NOT fire in the following scenarios:

Changing the selection on the right pane of the usage view

Changing the selection within a node in the Network Diagram view

	Syntax:
	Sub application_WindowSelectionChange(ByVal Wn as Window, ByVal Sel As Selection, ByVal Type as Long)

	Arguments:
	Window is the window where the selection change occurs.
Sel is the selection.
 Type is the type of data included in the selection. Member of PjItemType.


WindowBeforeViewChange. Occurs when the top pane view is changed within a project window.


	Syntax:
	Sub application_WindowBeforeViewChange(ByVal Wn as Window, ByVal CurrentView As View, ByVal NewView as View, ByVal ProjectViewControlVisible as Boolean, EventInfo as Object)

	Arguments:
	Window is the window where the view change occurs.
CurrentView is the current view (top pane) that the user is in. If the user was not in a project view before applying the current view, this value will return Null.
NewView is the new project view (top pane) that the user is trying to change to.
ProjectViewControlVisible returns True if the Project View Control is currently visible else it returns False.
EventInfo  EventInfo.Cancel is False when the event occurs. If the event procedure sets this argument to True, the value for the field specified with Field is not changed.


WindowViewChange. Occurs after the top pane view is changed within a project window. The event returns a Success argument that tells whether the view change action was successful or not.

	Syntax:
	Sub application_WindowViewChange(ByVal Wn as Window, ByVal PrevView As View, ByVal NewView as View, ByVal Success as Boolean)

	Arguments:
	Window is the window where the view change occurs.
PrevView is the previous top pane view that the user was in before the view change occurred. If the user was not in a project view before applying the current view, this value will return Null.
NewView is the new top pane view that the user has now applied
Success returns True if the view change action succeeded and False otherwise


WindowSidepaneDisplayChange. Occurs when the user clicks the toggle button on the Goal Bar to show/hide the Sidepane.

	Syntax:
	Sub application_WindowSidepaneDisplayChange(ByVal Wn as Window, ByVal Show as Boolean)

	Arguments:
	Window is the window where the sidepane is made visible or hidden.
Show is a parameter that is False if the user is closing the Sidepane, True if the user is showing the Sidepane.


ProjectTaskNew. Occurs when a new task is created.

	Syntax:
	Sub application_ProjectTaskNew(ByVal Tsk As Task)

	Arguments:
	Tsk is the task that was just created.


ProjectResourceNew. Occurs when a new resource is created.

	Syntax:
	Sub application_ProjectResourceNew(ByVal Res As Resource)

	Arguments:
	Res is the resource that was just created.


ProjectAssignmentNew. Occurs when a new assignment is created.

	Syntax:
	Sub application_ProjectAssignmentNew(ByVal Asg As Assignment)

	Arguments:
	Asg is the assignment that was just created.


ProjectTaskDelete. Occurs when a task is deleted.

	Syntax:
	Sub application_ProjectTaskDelete(ByVal Tsk As MSProject.Task)

	Arguments:
	Tsk is the task that is deleted


ProjectResourceDelete. Occurs when a resource is deleted.

	Syntax:
	Sub application_ProjectResourceDelete(ByVal Res As MSProject.Resource)

	Arguments:
	Res is the resource that is deleted


ProjectAssignmentDelete. Occurs when an assignment is removed.

	Syntax:
	Sub application_ProjectAssignmentDelete(ByVal Asg As MSProject.Assignment)

	Arguments:
	Asg is the assignment that is being removed


WindowActivate. Occurs when any project window is activated. This event is not fired when the application window is activated.

	Syntax:
	Sub application_WindowActivate(ByVal activatedWindow As Window)

	Arguments:
	activatedWindow is the activated window


 

WindowDeactivate. Occurs when any project window is deactivated. This event is not fired when the application window is deactivated.

	Syntax:
	Sub application_WindowDeactivate(ByVal deactivatedWindow As Window)

	Arguments:
	deactivatedWindow is the deactivated window


 

ProjectBeforeSaveBaseline. Occurs before a baseline is saved.

	Syntax:
	Sub application_ ProjectBeforeSaveBaseline (ByVal pj as Project, ByVal interim as Boolean, ByVal bl as PjBaselines, ByVal interimcopy as PjSaveBaselineFrom, ByVal interiminto as PjSaveBaselineTo, ByVal alltasks as Boolean, ByVal rolluptosummarytasks as Boolean, ByVal rollupfromsubtasks as Boolean, EventInfo as Object)

	Arguments:
	pj is the project displayed in the deactivated window
interim True is the user is saving an interim baseline, and false if the user is saving a full baseline.
Bl is a member of the PjBaselines enum and returns the baseline that the user is saving.
Interimcopy is a member of the PjSaveBaselineFrom enum and returns the interim plan that is being copied from.
Interiminto is a member of the PjSaveBaselineTo enum and returns the interim plan that is being saved into. 
Alltasks True if the user is saving the entire project, false if otherwise.
Rolluptosummarytasks True if the user has chosen to roll up baselines to summary tasks, false if otherwise.
Rollupfromsubtasks True if the user has chosen to roll up baselines from subtasks, false if otherwise.
EventInfo  EventInfo.Cancel is False when the event occurs. If the event procedure sets this argument to True, the baseline is not saved.


 
ProjectBeforeClearBaseline. Occurs before a baseline is cleared.

	Syntax:
	Sub application_ ProjectBeforeClearBaseline (ByVal pj as Project, ByVal interim as Boolean, ByVal bl as PjBaselines, ByVal interimfrom as PjSaveBaselineTo, ByVal alltasks as Boolean, EventInfo as Object)

	Arguments:
	pj is the project displayed in the deactivated window
interim True is the user is clearing an interim plan, and false if the user is clearing a full baseline plan.
Bl is a member of the PjBaselines enum and returns the full baseline that the user is clearing. 
Interimfrom is a member of the PjSaveBaselineTo enum and returns the interim plan that is being cleared. 
Alltasks True if the user is clearing the entire project, false if otherwise.
EventInfo  EventInfo.Cancel is False when the event occurs. If the event procedure sets this argument to True, the baseline is not cleared.


Microsoft Project 2000 Events with the new EventInfo object 
There are a number of Microsoft Project 2000 events that have the Cancel parameter. These events have been “duplicated” so that they use the EventInfo object parameter. These events are:

ProjectBeforeTaskDelete2 , ProjectResourceDelete2, ProjectBeforeAssignmentDelete2, ProjectBeforeTaskChange2, ProjectBeforeResourceChange2, ProjectBeforeAssignmentChange2, ProjectBeforeTaskNew2, ProjectBeforeResourceNew2, ProjectBeforeClose2, ProjectBeforePrint2, ProjectBeforeSave2
New Methods
Function Application::FieldNameToFieldConstant. This function returns a PjField constant given a field name.
 
	Syntax:
	Function FieldNameToFieldConstant(FieldName, [FieldType]) As Long

	Arguments:
	FieldName The name of the field whose constant is required. Required String.
FieldType The type of field. Member of PjFieldType. The default is pjTask. Optional Long.

	Returns:
	A member of PjField enum.


 
Function Application::FieldConstantToFieldName. This function returns a field name given a PjField constant.
 
	Syntax:
	Function FieldConstantToFieldName (Field) As String

	Arguments:
	Field The field whose string equivalent is required. Member of PjField. Required Long.

	Returns:
	A string.


 
Method Application:: SidepaneToggle:. This method fires the WindowSidepaneDisplayChange event.

	Syntax:
	Method SidepaneToggle()

	Arguments:
	None

	Returns:
	Nothing
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